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Workflows
This guide concerns designing, using, andmonitoring STEPWorkflows in the STEPWorkbench.Workflows are
managed within the workbench, though end users can access them via both workbench andWebUI. For
information on configuring and working with workflows inWebUI, see theWorkflows in Web UI section of the
Web User Interfaces documentation.

Workflowsmay be considered as a view or representation of real work within a company, allowing businesses to
manage and streamline the flow of tasks among varying groups, users, and system activities. A workflow definition
consists of a number of states that an object or task can be in at a given time, the legal transitions between these
states, and the events via which the transitions can be triggered. The flow being describedmay refer to an asset,
service, person, product, or other element that is being transferred from one state to another. For example,
introduction of a new product may involve work from a variety of business groups, such as Product Management,
Marketing, Creative, and Legal. Each group needs to interact with the product in someway, and likely have
differing sets of data required for this interaction. Some groupsmay not be able to do their work until another group
has completed theirs, while other groupsmay be able to act on the product in parallel.

The same principles apply for any other data types and any type of datamaintenance. Regardless of the type of
data or process being handled, an object in a state represents a task that requires work. For instance, a user could
be required to populate a set of attributes, and when completed, manually trigger a transition from one state to the
next. Alternatively, an object could be in a state waiting for data from an external system, waiting for a background
process to complete, or waiting for a specific event elsewhere in the workflow or in STEP in general, and thus not
require any direct human interaction.

STEPWorkflows are data-centric workflows, meaning that a workflow instance is defined as the relation between
a workflow definition and an object in the STEP database. An object can be inmultiple workflows simultaneously,
and each instance will have no impact on the others (unless the workflow definitions include business rules to
create a relationship between variousworkflows).

On top of the basic STEPWorkflow functionality, a number of additional features are available that make
workflows powerful tools for streamlining processes and ensuring data quality. These include, but are not limited
to, options to:

l Configure business rules to validate data, assign tasks, move tasks through workflows, integrate workflows
with other processes such as imports and exports, andmore

l Configure data views specific for each workflow state, allowing each actor in the flow to focus only on the data
most relevant for their tasks

l Support both static and dynamic task assignment and ownership, ensuring that the right actor sees the right
task at the right time

l Design for sequential and parallel execution of tasks, streamlining work processes for maximumefficiency

l Set deadlines and escalation actions, ensuring that tasks are completed in a timelymanner

l Configure dashboards for snapshot monitoring and KPI reporting, allowing administrators to quickly view and
assess key data points across the entire workflow
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The supported workflow enabled object types are:

l Assets

l Attributes

l Classifications

l Entities

l Lists of Values (LOVs)

l Planned pages

l Products

l Publications

l Publication sections

While workflows can become quite complex, the basics are really simple, and it is possible to get a small functional
workflow up and running in amatter of minutes. This guide will begin with the basicmaterial and work up tomore
advanced topics.
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Getting Started with STEP Workflows
This portion of thematerial introduces the user to basic STEPWorkflow functionality, including creating a simple
workflow and accessing taskswithin it. More advancedmaterial can be found in theAdvanced Workflow Topics
section of theWorkflows documentation, but it is recommended that users be well-versed in the introductory
topics before beginning advanced functions.

If you are new to workflows, it is recommended that you read thematerial in the suggested order, as topics build
upon one another.

However, if you are concerned only with the end user functionality (working with tasks in a workflow), as opposed
to designing and configuring a workflow, youmaywish to skip directly to theWorking with Tasks in Workflows
section of thematerial.

Suggested ReadingOrder:

1. Workflow Terminology

2. Workflow Related Privileges

3. Initial Setup for Workflows

4. Creating aWorkflow

5. STEPWorkflow Designer

6. Views andMappings for Workflows

7. Working with Tasks inWorkflows

8. ManagingWorkflows
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Workflow Terminology
This defines a list of commonly used terms in regards to workflows.

Action Type of business rule that can be executed on arrival in a new state (on-entry), on exit from a
state (on-exit), or on the transition between two states (on-transition). Actionsmaymodify data.

Assignee The user or group to which a task is assigned for work to be performed. User states can be
assigned directly to a named user or to a user group.When a state is assigned to a user group
the task is ‘offered’ to all members of that group. To perform the task associated with the state,
amember of the group has to claim the task. Once a task is claimed it is no longer visible in the
group task list; only the person who claimed the task is able to see it. A user may subsequently
release a task back to the group.

Automated
State

State in which the STEP system performs the required work and automatically progresses the
workflow when the automated work is complete. Typically requires the use of at least one
business rule.

Business
Rule

Automated activity that may implement customer-defined rules, such as validations, automatic
updates, notifications, data-driven workflow routing, etc. Also see Condition and Action.

Condition Type of business rule that can prevent a transition from being taken when an event is
attempted.Within a workflow, conditionsmay only be executed on attempted transitions (e.g.
before ’Proceed’ event is allowed, validate that all required data has been populated). A
conditionmay not change data.

Deadline Optional setting for time allowed for a task to be completed. If a deadline expires on a task it is
possible to perform an escalation.

Escalation The action(s) to be taken when a deadline expires. Escalations require at least one business
rule to be configured, which is triggered by the escalation.

Event The name associated with a transition between two states, such as Proceed, Reject, or Accept.
When a task is completed an event is triggered to transition an object to the next state(s) in the
workflow. In most caseswhere there is just a single event, this is called ’Proceed’ but in some
cases there is a need to support different routing via different events (e.g. ’Accept’ or ’Reject’) or
a different name is chosen to add clarity (e.g. ’Approve’).

Final State The state within a workflow or a parallel cluster that is the last step of this workflow or parallel
cluster. A final state cannot have any outbound events as there are no available transitions from
the state. Note that for parallel clusters, final states are used to auto-progress the workflow
when all concurrent parallel clusters have reached their final state.
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Initial State The first state that is activated within a workflow or within a parallel cluster of a workflow.

Task Thework and/or action that must be completed within a specific workflow state (whether by a
user or via automation).

Task Fields Fields (attribute, reference, workflow variable) that are available within a specific state for the
system or a user to access (view and/or populate). Task fieldsmay or may not be included in
the view.

Parallel
cluster

A set of states that form a sequential branch of dependent states whichmay run parallel to
other independent brancheswithin the sameworkflow.

State A step within a workflow to which a specific user, user group, or system can be assigned to
complete the task(s) associated with the state. Also see User State and Automated State.

Transition The change of tasks from one state to another.

User Sate State that requires a user to complete a task beforemarking the state complete. May include
some automation that happens on entry or exit of the state, but requires a user to trigger the exit
from the state (indicating completion of the associated task).

View The set of specific data points that are presented to the user in the STEP workbench when a
task is selected. Views are configurable by state and are only applicable for user states that will
be accessed directly from the STEP workbench. Views are not applicable for automated states,
and states accessed via aWebUI have interfaces defined via theWebUI configuration.Within
the STEP workbench, users can still choose to use the full set of workbench data and tabs to
work on workflow tasks if desired (and permitted via privilege configurations). However, a view
can streamline work processes so that only a small subset of fields that are directly relevant to
the task / state are displayed.

Workflow Business process(es) modeled as a series of states and tasks that can be executed by users
and/or automatic processeswithin the STEP system.Workflows prompt the next step of a
process to be started, by either creating a task for a user, or sending an alert. Workflowsmay
contain a number of process steps or tasks, as well as business logic.

Workflow
Attachment

A temporary asset attached to a task, that does not exist outside of the workflow.

Workflow
Variable

A temporary data point (similar to an attribute value) attached to a task, that does not exist
outside of the workflow.
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Workflow Related Privileges
There are a number of Setup Actions (privileges) directly related to STEPWorkflows, both in terms of allowing
users to configure workflows and to work with taskswithin workflows. In addition to workflow-specific privileges,
workflows also take into account general privileges. For example, if a user does not have access to a specific set of
objects or data points, theywill not have access to themwithin a workflow either, unless specific access is granted
within the workflow.

For complete information on privileges related specifically to workflows, see theWorkflows section of theSetup
Actions topic in theSystem Setup / Super User Guide documentation.

For information on editing general privileges to provide access to data or objects specifically within a particular
workflow state, see theEditing Privilege Rules section of the theSystem Setup / Super User Guide
documentation.
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Initial Setup for Workflows
In order to create workflows in STEP, some basic configurationmust first be completed. Specifically, the STEP
Workflow Type basic object typemust have a SetupGroup parent assigned, and a SystemSetup object of the
proper typemust have been created to hold the workflows.

In most cases, this setup will already be complete on a system and is only required if aWorkflows folder (or other
setup node enabled to workflow children) isnot present on the SystemSetup tab, as shown in step 7 below.

The setup described below is only required to be completed once on any system, but may be carried out multiple
times if it is desired to separate workflows for organizational purposes.

Enabling a Setup Group for Workflows
1. Go to SystemSetup and selectObject Types and Structures > Basic Object Types and verify that STEP

Workflow Type exists. If not, contact your system administrator for assistance.

2. Right-click onSetup Group type root underObject Types & Structures to create a new New Object
Type from the context menu.
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3. Enter an ID and a Name, and click Create.

4. Return to theSTEP Workflow Type node inObject Types & Structures > Basic Object Types. In the
corresponding editor, select the References tab and select Add Parent to link this to the folder created for
workflows under Setup Group type root. This enablesworkflow objects to be created as children to the
Workflows setup group root.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 14



5. To create the parent node for workflow instances to be created under, go to theMaintainmenu, navigate to
Insert, and selectSetup Group Root.
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6. Selection of SetupGroup Root opens the 'Create SetupGroup Root' dialog. Select the workflow object type
that was created in Step 3, enter an ID and Name, and clickCreate.
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7. This creates a folder in SystemSetup that a user can then create individual workflows under by right clicking
and selectingCreate STEP Workflow.
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Creating a Workflow
This topic describes how to create a basic workflow, which requires the following steps:

1. Create a new workflow

2. Create states in a workflow

3. Create transitions between states

4. Add events to transitions

5. Set assignees

6. Set validity

7. Set workflow options

Each of the steps is described in detail below, guiding users through the creation of a simple workflow, as shown
below.

In addition, a new workflow can be created via duplication of an existing workflow, so that topic is also covered in
this section.

Prerequisites
In order to create a workflow, the systemmust first have a place established to house the workflow. This setup
only needs to be completed once on any system, and is likely to have already been completed. However, if the
SystemSetup tab does not have a folder that allowsworkflow children (as shown in the Step 1: Create a New
Workflow section below), then this initial configuration needs to be completed before anyworkflows can be
created. The steps for the configuration are detailed in the Initial Setup for Workflows topic.

Preconsiderations
Steps 1 - 3, and step 5, of workflow creationmust all be completed in a single session in order to save the workflow
configuration. Therefore, care should be taken during initial configuration to ensure that the steps can be
completed and work is not lost.

Each of the below must be true in order to save a workflow configuration:
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l A unique ID must be specified for the workflow

l Theremust be an Initial and a Final state on the outer level

l All statesmust be reachable (e.g. theremust be at least one incoming transition for each state)

l State IDsmust be unique within the workflow

l All statesmust have an associated assignee, or a default assigneemust be assigned to the workflow

Step 1: Create a New Workflow
1. Right-click the folder established to house all workflows, and selectCreate STEP Workflow.

2. TheSTEP Workflow Designer will open. Additional information about the designer can be found in the STEP
Workflow Designer topic. For now, simply enter an ID and Name for the workflow.

At this point, a 'container' has been created, to which states and transitionsmust be added to build the actual
workflow.
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Step 2: Create States in a Workflow
A state represents an assignment to be completed, whether by a human or a system.When a new workflow is
created, it must have a single initial state at the outermost level, which is where any task entering the workflow will
begin. In addition, a single final statemust be present at the outermost level to indicate completion of the workflow.
The indication of 'initial' or 'final' for a state is considered a characteristic of the state. States can also have 'parallel'
or 'cluster' characteristics, which are required when workflows have parallel states and/or when a set of states
should be grouped together within a workflow (comparable to amini-workflow within the overall flow).

For this example, we will create a basic workflow using three states: an initial state, a standard state, and a final
state. However, further descriptions of state characteristics, includingmore complex examples using parallel and
cluster states can be found in theState Characteristics in Workflows topic of theAdvanced Workflow
Topics documentation.

1. To create the Initial State, right-click the canvas area and selectAdd > Initial State from themenu. The
Initial State is the first state that any object started in the workflow is placed into.

2. In the State Editor that appears, type the desired ID andName of the state. Make sure that Initial under
Characteristics is checked, and close the dialog box by clicking the 'X' in the top right corner.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 20



Note that IDs can be revised as needed before the workflow is saved. However, because workflow business rules
are tied to state IDs, all state IDs are locked upon saving of the workflow.

State names are editable at any time, and can also be localized, allowing users to see differing names for the same
state based on locale. More information on this can be found in the Localizing Workflow State Names and
Events section of theWorkflows documentation.

3. Create a second state by right clicking the canvas and selectingAdd > State.

NoCharacteristics need to be checked in the State Editor dialogue box for states in between the Initial and
Final States.
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4. For the last state, right-click the canvas area and selectAdd > Final State. In the State Editor box, fill in the ID
and Name accordingly, making sure that Final is checked underCharacteristics. Close the dialog. The
workflow should now appear as pictured below.

You have now created a basic workflow with three states. However, in order for tasks to be able tomove through
the workflow, transitionsmust be added between the states.

Step 3: Create Transitions Between States
Transitions are needed between states in order for the workflow to be valid. Each state (with the exception of final
states in the outer level) should have at least one transition to allow tasks to proceed through the workflow. States
may havemore than one transition, meaning there aremultiple options for exiting the state. For example, users
may need the option tomove a task to a subsequent state in the workflow, aswell as returning it to a previous state
(e.g. to proceed or reject).

1. Hover over the center of the Initial State so that the cursor changes into a hand icon and a green box appears
around the state. Click and drag to the center of the next desired state until a green box encircles that state.

Release themouse click to create the transition, which is then displayed as an arrow between the states.
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2. Repeat step 1, but going in the opposite direction (e.g. click the second state and drag to the first).

Now there are two transitions going in opposite directions in the workflow. This allows objects to progress
forward in the workflow if approved or to be rejected and sent back to a previous state if needed.

3. Though they appear as a single arrow at this point, each transition is actually unique, which can be seen by
adding corners to each transition. To do this, right click on the arrow and selectAdd Corner.

A green boxwill appear on the transition.

Click and drag the box to the right or left.

4. Repeat the above steps to add a corner to the other existing transition, and to add a new transition between the
second and third states. When complete, your workflow should appear as shown below.
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Step 4 - Add Events to Transitions
While not strictly necessary, adding events to transitions can increase usability of workflows as the event names
are displayed to the end users. When ameaningful event name is applied, it provides an indication to the user of
what is occurring when they select to Submit a task in the workflow.Whenmultiple transitions are present from a
single state, it is especially useful to have events applied so that a user can choose which selection tomake (e.g.
Proceed vs. Reject).

Events also enable advanced workflow options, such as applying business rules and logic to specific events. More
information on advanced functions is available in theAdvanced Workflow Topics section of the documentation.

To add an event to a transition, follow the below steps.

1. Double-click the transition, select theEvents tab in the Transition Editor dialog that appears, and then click
theAdd Event icon button. Name the event accordingly and clickOK.

Note that if a space is put in the event name, the Designer will automatically replace the space with an
underscore within the editor. However, when the event is displayed to end users in the workbench or WebUI,
the underscoreswill render as spaces.
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2. Additional events can be added to the same transition, which can be useful when adding business rules to a
workflow. However, for this simple example, we will use only one event per transition so the Transition Editor
should be closed by clicking the X in the upper right corner. Once closed, event names can be dragged on
the canvas to improve visibility if needed.

3. Repeat the above steps to add an event to each remaining transition, resulting in a workflow comparable to
the one shown below.

Note that multiple events within the workflow may have the same name.

You have now created a basic workflow, but in order to make it valid (which is required to enable saving of your
work), an assigneemust also be specified for the workflow.

Step 5: Set Assignees
Each state in a workflow requires an assignee to be set, regardless of whether the state represents a human task
or not. The object-in-state relationmust always be assigned to a STEP user or user group. This can be done one
of two ways: individual assignees to each state or a single assignee to the overall workflow. If states do not have
an assignee defined locally, theywill by default always inherit the assignee defined by the workflow.

As the primary purpose of workflows is to assign tasks to varying actors in a controlledmanner, each workflow
state that requires human interaction will generally have a different assignee (rather than using the workflow
default). In contrast, states that represent a system action or an automated state will often use the workflow
default, which can be set to an administrator user group.

Note: Users that do not have the STEPWorkflow Administrator privilege will only be allowed to see tasks
assigned to themselves or a group they aremember of.

There are several options for setting assignees in a workflow, including to set assignee dynamically based on
information on the object or previous actions taken in the workflow. For this example, the basic functions of
specifying a user or group assignee are described. More advanced assignee options are described in the
Assignees in Workflows section of theAdvanced Workflow Topics documentation.

Once assignees have been set, the workflow should be saved:

© Stibo Systems - Confidential - STEP Trailblazer 8.1 25



Set an Assignee for a State
All states with user interaction should have an assignee specified. To set the assignee locally for a state, double-
click the state, select theAssignee tab in the State Editor dialog that appears, click theSelect User / Group
radio button, click the ellipsis button to open the Assignee Selection dialog, select a user or user group, click
Select to close the selection dialog, then click the X in the upper right corner to close the State Editor dialog.

When a user group is selected, all users in that group can access tasks in the state. When a specific user is
selected, only that user (or a workflow administrator) can access tasks in the state. It ismost common to assign
states to user groups rather than to individual users so that tasks can continue to be processed even if a specific
user is unavailable, for example when sick or on holiday.
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When a state has an assignee, the letter 'A' with a circle around it will appear in the state:

If the assignee indicator does not appear, go to the View menu in the STEPWorkflow Designer and check the
View Content Indicators option.

The above actions can be repeated until an assignee has been designated for each state in the workflow.
Alternatively, an assignee can be set for the complete workflow.When each state has an assignee (via individual
assignment or the workflow default), the workflow can be saved via File > Save.

Set an Assignee for the Workflow
In order to save a workflow, all statesmust have an assignee specified. All states that do not have an assignee
explicitly specified will inherit the workflow assignee. Therefore, it is often helpful to have a default assignee
specified, simply to ensure that the workflow can be saved at any point. In addition, it is common to use the
workflow assignee for states that are automated and/or the work occurring in the state is done by the system
rather than a user as in these cases the assignee is not ameaningful designation. Typically the default workflow
assignee will be an administrator user or group.

To set the default assignee for a workflow, double-click the title bar of the workflow, click theSelect User / Group
radio button, click the ellipsis button to open the Assignee Selection dialog, select a user or user group, click
Select to close the selection dialog, then click the X in the upper right corner to close the State Editor dialog.
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When each state has an assignee (via individual assignment or the workflow default), the workflow can be saved
via File > Save.

Step 6: Set Validity
Before a workflow is fully functional, it must bemade valid for the object type(s) that will use it. For example, if a
workflow wasmade specifically to review and approve packaging objects and data, it might bemade valid for
Each, Box, Carton, and Case.

To set validity, select the workflow from theSystem Setup tab, click theValidity tab, and check the appropriate
object type(s). Any number of object types can be selected within the same flipper.
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Note:Workflows can bemade valid for several object types, but only types of the same 'super type.' As an
example, you couldmake a workflow valid for the object types 'Shipping Address' and 'Main Address' of the super
type 'Entities', but not also for 'Building Photo' of the super type 'Assets.'

Step 7: Set Workflow Options
The final step in creating a workflow is to set the options available on the STEPWorkflow Editor tab. These
settings are not required to be changed, but they provide valuable options for governing the behavior of the
workflow and should be considered as part of anyworkflow design.
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Initiate automatically - If checked, objects of the specified validity for the workflow are automatically initiated into
the workflow upon creation. This option is only applicable for object types for which instances of the objects can
exist in the Tree (e.g. products, classifications, assets, entities, publications, publication sections, or planned
pages, but not for attributes or lists of values). This is useful for onboarding / creation workflows that are intended
to process new objects as the objects are automatically placed in the workflow upon creation, without anymanual
initiation required.

Listen on updates from Import - If checked, the systemwill listen for updates on objects of the type specified by
the validity of the workflow and take action as needed. Specifically, an object can be transitioned from one state to
another upon update of the object via import. This is especially useful when completion of a workflow requires
information from another source system. As soon as that information is received, the task can be automatically
sent to the next state in the workflow. This function is only available for assets, classifications, entities, and
products and requires additional configuration to enable. Complete configuration is described in the Triggering
Workflow Events from Imports section of theAdvanced Workflows Topics documentation.

Use executing user's write privileges - Option related to the execution of business rules in the workflow. If
selected, a user triggering the execution of a business rule will be prevented frommaking any changes or
accessing any data in the system via the business rule that he / she is not normally privileged to. For example, if the
user is not privileged to change a certain attribute value on an object, and the business action is configured to
make such a change, a privilege exception will be thrown and the action will not be carried out. Caution should be
used with this option as it can prevent desired business rules from being carried out and/or result in errors that the
business rule should be written to handle gracefully. If the option is not checked, business rule are run with full
access to carry out all indicated rules.

Disable transitions on terminated Workspaces - If selected, it will not be possible to perform transitions in
terminated workspaces (e.g. the Approved workspace). Typically this option should be checked as it will prevent a
user from submitting objects while in the Approved workspace. This is important as data cannot bemodified in the
Approved workspace, submission of a task to a state often involves business actions, and workflow actions are
executed from the current workspace. Therefore, if a user is viewing data in the Approved workspace and
attempts to submit an object from a state where submission involves the use of a business action, the user will
receive an error. Checking this optionmakes the submission unavailable, and therefore prevents the user from
receiving an unnecessary error.

Start Condition - Option available to specify a business condition that needs to be fulfilled before the workflow
can start. For example, if some basic data is required to be populated prior to initiation, a condition can be selected
to ensure that the required data is present. If the condition is not met (e.g. does not evaluate to true), the object will
not be allowed to enter the workflow.

Important: If users will be working with taskswithin the workbench (rather thanWebUI), views andmappings
should also be configured following creation of the workflow. Instructions for this configuration are available in the
Views andMappings section of the Getting Started with STEPWorkflowsmaterial.

Duplicate a Workflow
Another way to create a workflow is to duplicate an already existing workflow.While theremay be a number of
reasons for duplicating an already existing workflow, some of the reasonsmay include:
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l The need tomake changes to a workflow already in use. In duplicating the workflow, it is possible tomake
changes to the new workflow and test these changeswhile still leaving the old workflow intact.

l The need to create a new workflow similar to an existing workflow.

Duplicating a workflow will result in the basic workflow structure and associated business rules being copied.
However, the global workflow options (Step 7 in the previousmaterial) will not be copied and should be set
manually on the duplicated workflow. In addition, workflow-specific privileges are not carried over in a duplication.

To duplicate an existing workflow, go to SystemSetup and right click on the desired workflow for duplication.
SelectDuplicate. In the dialogue that appears, populate the ID and Name, and click the OK button. The
'Duplicate references' option is not applicable for workflows and can be left checked or unchecked.
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STEP Workflow Designer
This topic provides an overview of the STEPWorkflow Designer, including descriptions of the various sub-editors
and visual indicators within the designer. It is intended to orient you with the interface and provide general
information for where to accomplish things in the designer, rather than to complete any specific task itself. When
applicable, links tomore detailed task-orientedmaterials are provided.

Prerequisites
It is expected that the reader is familiar with theCreating a Workflow topic.

Overview
The STEPWorkflow Designer has 5 primary areas:

1. Properties panel for setting ID andName
2. Area for definingWorkflow Variables/Attachments
3. Area for displayingValidation errors and warnings
4. Overview / zoom area

5. Canvaswhere States and Transitions are defined
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Dialogs within STEP Workflow Designer
There are a number of dialogs that havemany additional options and features that aid users in editing workflows.
Each dialog and the general functions of the included tabs are described below.

Workflow Editor
To edit in theWorkflow Editor, double click the canvas region. The workflow editor is used tomake changes that
are global for the workflow, including setting the default assignee for the workflow and enabling status flags for the
workflow.
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Tab Available Functions

Assignee Tab Modify the assignee for the entire workflow. SeeWorkflow State Editor Assignee Tab
Options.

Status Flags
Tab

Status Flags can be added and removed. SeeStatus Flags.

State Editor
The State Editor is launched when the user right-clicks on the canvas to add a state, or when a user double-clicks
on an existing state. This editor enables users tomake changes specific to a particular state.
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Tab Description

Assignee Assignees can be added / removed / modified per state. SeeAssignees in
Workflows.

Comments Comments can be added / removed / modified. Comments have no explicit function and
are not viewable outside of the designer. However, they can be useful to make notes for
designers regarding a particular state (e.g. intended function, considerationswhen
modifying, etc).

Deadline/Escalation Set deadlines and add / modify / delete associated escalation business rules. See
Deadlines and Escalations.

Mandatory
Attributes Tab

Set attributes and/or attribute groups that are required to be populated before a task can
leave the state. SeeMandatory Attributes in Workflows.

On Entry Add / modify / delete business actions that are run on entry to the state. SeeBusiness
Rules in Workflows.

On Exit Add / modify / delete business actions that are run on exit from the state. SeeBusiness
Rules in Workflows.

State Change the name or characteristics of the state. SeeState Characteristics in
Workflows.
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Tab Description

WebUI Screen
Mapping

Provides a link to theWebUI tomap the state to a specificWebUI screen. From the
dropdown, select theWebUI that should have access to the workflow, and click the Edit
button. This will launch the login page of theWebUI. The user must have privileges to
edit WebUI configurations and if so, logging in will open the designer to the Screen
Mapping properties with conditions tomap to the workflow state pre-populated. The
user can then select an existing screen tomap the state to. More information on
mappingWebUI screens can be found in theMain Properties topic of theWeb User
Interfaces documentation.

Transition Editor
The Transition Editor is launched when the user double-clicks on an existing transition. This editor enables users
tomake changes specific to a particular transition.

Tab Description

Condition Add / remove / modify business conditions on the transition. SeeBusiness Rules in
Workflows.

Events Add / remove / modify events on the transition. SeeAuto Routing Tasks in a Workflow.

Mandatory
Attributes

Set attributes and/or attribute groups that are required to be populated before a task can take
the transition. SeeMandatory Attributes in Workflows.

On
Transition

Add / remove / modify business actions on the transition. SeeBusiness Rules in Workflows.
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Visual Indicators in STEP Workflows
Several visual indicators are present to allow users to quickly gather information about the workflow without
having to open a particular state or transition.

Indicator Description

'A' A assignee has been specified for the workflow or state. SeeAssignees in Workflows.

'D' A deadline has been selected for the state. SeeDeadlines and Escalations.

'I' An 'On Entry' action is present on the state. It may help to remember this as 'I' for 'In' (e.g.
into the state). SeeBusiness Rules in Workflows.

'O' An 'On Exit' action is present on the state. It may help to remember this as 'O' for 'Out' (e.g.
out of the state). SeeBusiness Rules in Workflows.

'P' Specific user privileges have been granted for the state. SeeEditing Privilege Rules.

Dotted
transition line

A condition has been placed on the transition. SeeBusiness Rules in Workflows.

Rounded end
on transition

An action has been placed on the transition. SeeBusiness Rules in Workflows.

Blue color The state has the Final characteristic. SeeState Characteristics in Workflows.

Dark gray color The state has the Initial characteristic. SeeState Characteristics in Workflows.

Light blue / gray
color

The state has the Cluster characteristic, or no characteristics (e.g. standard state). See
State Characteristics in Workflows.
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Views and Mappings for Workflows
While not strictly necessary, if users are going to work with workflows in the STEPWorkbench, it is generally
recommended to create views andmappings for the workflow. This ensures that users have access to the right
information to complete their tasks and streamlines the work process. However, users can also use the standard
editors available on objects in the Tree if desired, using theWorkflow navigator only to submit tasks rather than to
review and edit data.

When a workflow state is selected in the STEPWorkflow navigator tab, the information that displays is called a
view. The act of applying that view to a particular state in a workflow is calledmapping.When configuring a
workflow it is important to decide what data is visible for objects (views), and define which states to display
(mappings). Without views andmappings configured, all states in the workflow are displayed on the STEP
Workflow navigator tab (including parallels, clusters, and final states). Additionally, just the ID of the objects in the
selected state display in the STEPWorkflow Items editor or the Task tab on the object.

Uponmapping views to states, only the states for which amapping exists will be displayed in the STEPWorkflow
navigator tab. The configured viewswill be used in the STEPWorkflow Items editor and on the object's Tasks tab.
This allows for customization, so if a user wanted to show only human-related tasks, they can leave out mappings
for any states, parallels, or clusters that are not human tasks. Additionally, the sequencing of mappings determines
the order in which the tasks are displayed in the STEPWorkflow tab.

Note that while views andmappings can be applied to a blankworkflow canvas, it does not generallymake sense
to do so. Therefore, it is expected that a workflow has been created prior to any views or mappings being applied.
See theCreating a Workflow topic for detailed instructions on workflow creation.

Before creating views or mappings, it is important to be aware of the following points:

l The views andmappings configured in the STEPWorkflow Designer only apply to workbench and notWeb
UI. Views inWebUI are defined by the configuration of the screen. If users will not be interacting with
workflows in the workbench, it is not necessary to configure workbench views. Instead, see theWorkflows
in Web UI section of theWeb User Interfaces documentation.

l A view can contain both object and workflow-specific data. Thismeans that a view can contain attributes,
attribute groups, and aspects information specific to the object (such as name, ID, approval status, etc) as
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well as elements like workflow assignee, deadline, workflow variables, and workflow attachments.

l A view can bemapped tomultiple states. For example, if a state is assigned to a particular user or group
early on in the workflow to edit data, and again later in the workflow to review data, it is possible that the
same data points should be available to them in each state. In this case, the view only needs to be configured
once, and that view can then bemapped to each applicable state.

l Once a view or mapping has been started for a workflow, even if they are then deleted to be completed at
another time, no states will show in the STEPWorkflow tab until views andmapping are completed.

The details for configuring views andmappings are covered in the subsequent topics,Configuring Views for
Workflows andConfiguring Mappings for Workflows topics.
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Configuring Views for Workflows
This topic details how to configure views for states. Without views configured, end users will only see the ID of
objects in a workflow when accessing tasks via the STEPWorkflow navigator tab or the Tasks tab on the object.
Therefore, if users will be interacting with the workflow in the STEPWorkbench, it is recommended to have views
in place so that the user can easily see the data points relevant for their tasks in that state.

Note: There is no need to configure views for workflows that will be accessed only inWebUI. For information on
working with workflows inWebUI, see theWorkflows in Web UI sectionof theWeb User Interfaces
documentation.

The steps below describe how to create views for a workflow accessed in workbench, and provide reference
material for the various view options.

1. To begin creating views, select the desired workflow in SystemSetup, and open the STEPWorkflow Designer
by going toEdit > Edit Workbench Views and Mappings.

2. When the View Editor opens, it will be blank. Right-click on the left side of the panel and selectAdd View.
Provide an ID for the view.
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3. Once a view has been created, columns can be added by right-clicking on the view, selectingAdd Column,
and choosing a type of data to add to the view. Asmany columns can be added as needed to provide all
necessary information to the user.

The Attribute, Attribute Group, and Aspect options are all for displaying object data, while the Component
option is for displaying data specific to the workflow task (e.g. a workflow variable, attachment, assignee, etc).

The below sections describe the various view options in more detail, as well as how to reorder columnswithin a
view.

Important: For views to take effect, each view must bemapped to one or more states. For details onmapping
views, seeConfiguring Mappings for Workflows.
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Attribute
The 'Attribute' column type is used to insert a single attribute into the view. The validity of the attributemust match
the validity of the objects in the workflow, or else the attribute will not be displayed in the view. Additionally, if
working with specification attributes on products, the attributemust also be linked appropriately in the hierarchy to
be valid for the workflow objects.

An attribute can be configured as 'ReadOnly' and/or 'Mandatory'. Attributesmarked as 'ReadOnly' are not
editable on the STEPWorkflow Items or Tasks tabs. The 'Mandatory' setting will give a visual indication that the
attribute is required by showing an asterisk (*).

Note: TheMandatory checkbox in view configuration provides a visual indicator only - it doesNOT enforce that
the attribute is populated. If the attributemust be populated prior to exiting the state, the attributemust bemarked
asmandatory using theMandatory Attributes tab of the state or transition editor. More information on this is
available in theMandatory Attributes in Workflows section of theAdvanced Workflow Topics.

To add an attribute to a view, right-click on the view > Add Column > Attribute. Use the ellipsis button [...] to
select an attribute, andmark the ReadOnly and/or Mandatory options as needed.

It is worth noting that if a field is highlighted in red, thismeans that the value ismandatory for approval of the object,
independent of the workflow or state. This type of mandatory is set on the attribute by settingMandatory = Yes. As
with themandatory indicator in the view, this does not force the user to populate a value within the state.

Attribute Group
The 'Attribute Group' column type is used to insert all attributes in a group into the view. The same considerations
apply as for a single attribute, described above.

Aspect
Via the Aspect option, it is possible to insert columns for ID, name, object type, revision, and other basic data for
the object.

To add an aspect to a view right-click on the view > Add Column > Aspect. Click the appropriate radio button for
the desired aspect. A full description of what each aspect option is can be found in the table below.
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Aspect Description

id Displays the ID of the object, which is not editable.

name Displays the STEP Name of the object, which is editable if privileges allow.

object type Displays the object type of the object. If privileges allow for editing, a dropdown
is present fromwhich valid object types can be selected.

revision Displays the revision number, as well as when the object was last edited and by
whom. The field is not editable.

path Displays the path of where the object exists in STEP. The field is not editable.

approved Displays the approval status of the object and date / time of last approval if
applicable. The field is not editable.

translation Displays the translation status of the object, for example: Up to date, In
Progress, Not Translated, etc. (not editable). For more on translations, see the
Translation documentation.
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Aspect Description

indesign_
template

Displays the STEP InDesign template being used for print. By clicking on the
hyperlink, the user is brought to the template.

quark
template

Legacy option that should not be used in current implementations.

Note that Unique Key is not a selection option. If it is required to display the key value of an object, the attribute(s)
driving the key should be selected using the Attribute or Attribute Group options.

Component
TheComponent option gives access to a list of data specifically related to workflows, including assignee, workflow
attachments, workflow variables, etc.

To add a component to a view right-click on the view > Add Column > Component.

Populate the Title (header for the column in the view), selectRead Only orMandatory as appropriate, and select
a component from the dropdown. Note that selection of a component may result in additional selection options.
For example, selection ofWorkflow Variable yields an additional dropdown to select the specific variable to be
used. Each component option is described in detail below.

Read Only andMandatory fields are not applicable on all components and are grayed out in that case.When
available, fieldsmarked as 'ReadOnly' are not editable on the STEPWorkflow Items or Tasks tabs. Checking
'Mandatory' means that an asterisk (*) is shownwith the Title to indicate to users that the field should be populated.
However, it does not enforce that the field is populated prior to the task exiting the state.

DeDuplication
Adding the DeDuplication component to a workflow view allows a user to see if there are any objects in the system
that have been flagged as potential duplicates by amatching algorithm.
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If potential duplicates have been identified, a Duplicates button is present that the user can click to access a list of
possible duplicates for the selected object in the workflow. Clicking the Differences button opens a Compare
screen where the user can view differences and confirm or reject duplicates.

For additional information on deduplication workflows, see theClerical Review topic in theMatching and
Linking documentation.
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DTP Task Info Provider
Component that can be used if a user wishes to show task data in the InDesign plugin tasks tab. It will not be
rendered in the workbench. The Variable ID will be used for value-name and the column Title will be description.

Pluginable Cell Debug
Experimental debug option that generally should not be used.

Pluginable Cell Primary Image
Component for displaying the primary image of the object.
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The component displays a thumbnail of the primary image. Note that the image and reference are both not
editable (e.g. images cannot be added or removed using this component).

Note: If end users need to edit references (primary image or otherwise), this can be done using the standard
editor functionality on the References and Referenced By tabs.

The reference type used to identify the primary image is set in SystemSettings (SystemSetup > Users & Groups
> Primary Image Type). The STEP ID of the reference type that should be usedmust be entered in the Value field.
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Vendor
Vendor is used to display the name of the vendor / supplier that the object is assigned to. This is typically used for
systems that have a Supplier hierarchy in place. More information on this setup is available in theSupplier Web
UI Setup Guide in theWeb User Interfaces documentation.

The component displays the name of the supplier classification folder that the object is linked to (object will be in
the Products sub-folder), using the reference type indicated in the 'Link type for vendor classification to product
link' system setting.
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Workflow Assignee
Used for displaying the current assignee and/or letting users with the STEPWorkflow Administrator privilege re-
assign the current task to another user / group.

If to be used for re-assigning, either theUser Groups orUsers parameter (or both) must be populated.
Selectionswill be the available assignees.

If theExpand User Groups checkbox is selected, all users in the selected user groupswill be available for
selection / assignment (as well as the user group itself). Note that when a privileged user selects a user / group to
re-assign the task to (in the STEPWorkflow Items editor or on the object Tasks tab), the re-assignment will occur
immediately, and the taskmight disappear upon refresh.
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TheOutput Var parameter can be used to select a workflow variable to write the public ID of an assignee. If a
selection ismade here, when an end user populates the cell, no reassignment takes place and no special
privileges are required. The use for this is that a user is able to select a 'future' assignee - the actual assignment
must be done later by a business action that looks up the assignee using GroupHome / UserHome. If the same ID
is used on both a group and a user, the component will use the group, as it's found first.
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For more on Assignees and the description of the various options for theWorkflow Assignee component, see the
Assignees in Workflows topic in theWorkflows documentation.

Workflow Attachment
A component that lets users add, open, download, and deleteWorkflow Attachments. Use of this requires that a
Workflow Attachment has been previously set up in the STEPWorkflow Designer (and saved) so that it can be
selected in theAttachment dropdown.
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Note: If marked as 'ReadOnly', the add and delete optionswill be disabled, but users will still be able to open and
download attachments.

For more information onWorkflow Attachments and the features in this component, seeWorkflow Attachments
in theWorkflows documentation.

Workflow Deadline
Users with the STEPWorkflow Administrator privilege will be able to set, edit, and delete task deadlines. Users
without the privilege will see different icons depending on whether the deadline is reached or not. Deadlineswill be
displayed when a user hovers over the icons.

Note that the editability of the deadline field is determined solely by privileges, and therefore the ReadOnly setting
is not applicable for this component.
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For more on this see Deadlines and Escalations in Workflows in theWorkflows documentation.

Workflow Linked Name
Component for displaying the object name as a link taking the user to the configured object editor. When the
component is selected, default values are populated, which take the user to the standard editor for each super
type of objects (e.g. the Product tab in Tree view for "blue" objects in STEP). However, these default values can
be edited so that the user is directed to another tab when clicking the hyperlink in the view (e.g. to the References
tab or Images & Documents). To change the default, go to the desired editor and look at the STEP URL field. The
value to be entered is the value following "editor=" in the STEP URL (see the examples below).
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To edit the default configuration for where the link should navigate to when clicked, go to the desired location in
Tree and check the URL field. For example:
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Workflow Note Column
Component for displaying themost recent ProcessNote or TransitionMessage. If not configured asReadOnly, a
new note can be added, and will persist throughout the workflow. If the field is hovered over in the end user view,
the configured number of recent entries entered in theMax Entries field will display. Along with themessage, the
user info and time-stampwill also show.

TheShow Transition Messages andShow Process Notes parameters are used to define the types of notes
displayed. Caremust be taken whenmaking these selections as they significantly impact the user experience.
Typically only one option will be selected, as appropriate for the intended use.

l Show Transition Messages:Check this if a message is provided at the time the task is submitted, and the
next user should see that message. If nomessage is provided at the time of transition, a transition is still
logged, though without amessage (e.g. time, date, and user can be seen upon hover but no corresponding
message is displayed). The intent of this is for serial workstreamswhere one user will need to see a
message entered from the immediately preceding user, but is unlikely to need to see previously entered
messages from those further upstream. Therefore only themessage entered by the last user is displayed in
the view.

l Show Process Notes:Check this if users will enter noteswhile working with tasks, and the notes should be
visible to the next user. The intent of this is that the current user needs to pass information to one or more
subsequent users, and they enter themessage while working with the task (e.g. prior to submission). The
most recently entered note will always be available in the direct view, with additional notes available upon
hover.
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l Both:Use caution when selecting both parameters in the same column. Themost recent transition
message is always displayed in the view (if nomessage was entered, the view displays no value). Any notes
entered outside of the submit message are only available upon hover (even if a transitionmessage was not
provided). If a transitionmessage is always provided, this can be a valid setup. However, if transition
messages are not guaranteed, it can appear to the end user that nomessages are present, when in fact
process notes have been provided. If both process notes and transitionmessages need to be available, it is
recommended to add the column to the view twice with only one parameter checked in each so that both
process notes and transitionmessages are shown independently.

Workflow Planned Page
Component that can be used in workflows valid for Planned Pages. It will show a thumbnail of the plan, Sticker
book, or Mounted pages (as directed by theView choice parameter), and links directly to the selection when
clicked.
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Workflow Task Column
Component for letting users claim / release a task. Users will not be able to work on tasks not assigned directly to
them, so if a task is assigned to a user group they are amember of, they have to claim it in order to work with it.
When a task is claimed, it is possible to release it again, assigning it back to the latest group assignee. If the task
has never been assigned to a user group, the task is assigned to the default assignee for the state.

This component is especially useful for states where the assignee initially is a user group and the desire is to let
users in that group claim and complete tasks.
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For more on task ownership, see theAssignees in Workflows topic in theWorkflows documentation.

Workflow Variable
Component for viewing and editingWorkflow Variables, which requires selection of theVariable that shouldme
made available. If the selected variable is bound to an attribute and the component is configured to not be Read
Only, the cell editor matching the validation base type of the attribute will be used (e.g. a date picker for attributes
with a type=Date).

For more on variables, see theWorkflow Variables topic in theWorkflows documentation.

Workflow Variable User List
Component for letting the user select from a list of users. The typical use case for this component is one where a
user, as part of one task, selects who should handle a subsequent task. The ID of the selected user is then stored
in the workflow variable specified in theOutput Var parameter. From there, it can be used to apply an assignee in
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a subsequent state using the Fetch from Variable assignee option in the State Editor Assignee tab.

An existing workflow variablemust be selected in theOutput Var parameter. This is used to store the selection so
that it can be accessed later in the workflow (e.g. at the time of task assignment in a subsequent state).

One of the three selection parametersmust be configured (Group, Group Var, Config Prop). The three properties
are evaluated in the order shown. Therefore, if Group is populated, it will be used, andGroup Var and Config Prop
will not be evaluated.

An existing User Groupmay be selected in theGroup parameter, and the users in that group will then be available
for selection by the end user. This is used when users will always choose a user fromwithin the selected group. If
the user group that users need to select an assignee from can vary based on other factors, then theGroup Var
parameter should be used. From this, an existing workflow variablemust be selected, and it is expected that at
some point in the workflow (prior to the state for which the view is being configured), the variable has been
populated with the ID of a User Group. The system then reads the ID from the workflow variable on the task and
makes the users from the corresponding user group available for selection. A Config Prop option is also available
where the ID of a configuration property can be supplied and the user group will be read from there. This is
typically only used in conjunction with extensions.
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For more on variables, see theWorkflow Variables topic in theWorkflows documentation.

For more on Assignees, see theAssignees in Workflows topic in theWorkflows documentation.

View 'Sort On' Option
The Sort On option allows tasks in the workflow to have a default sort order specified by a particular column. An
integer can be entered to indicate the column that should be used for sorting (1= first column, 2= second column,
etc.). An example is below.

With no sort order specified, the items are in no particular order in the STEPWorkflow Items tab.
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However, when a number is put into the Sort On option to distinguish what column the view should be sorted by,
the items are sorted in ascending order. Notice that in the View Editor, in the first view the object name appears in
the first column. To sort by this, the user types in 1 to represent the first column in this view.

All objects in the workflow in this particular view are now sorted according to object name.

If the optionSort Columns Automatically is checked, the Title parameter for each element of the view is used
and columns are sorted in alphabetical order based on this value, excluding aspects. To clarify, all columns of the
'Aspect' type (e.g. ID, Name, Revision, etc) appear first in the view, followed by all other elements listed in
alphabetical order by Title.
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Ordering Columns in Views
It is possible to reorder the data selections in a view by right-clicking on any element of the view and selecting
either Move Up or Move Down, depending on what options are given according to the current position. The order
of columns in the View Editor determines the order in which they are displayed to the end user so care should be
taken in the ordering.
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Using the XML View Editor
In addition to the Editor tab on the View Editor dialog, there is also an XML tab. This tab shows an XML
representation of the defined views andmappings, allowing users to create and configure views via XML rather
than right-clicking. This can be especially useful when a number of similar views need to be configured and
workflow designers need to indicate only a few differences between them. In addition, the XML editor can be used
to copy views acrossworkflows, which is helpful whenmultiple workflows use a similar view, but the workflow itself
differs and should not be copied (e.g. onboarding andmaintenance workflows).
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Configuring Mappings for Workflows
This topic details how tomap a view to a workflow state (or states), as well as how tomap views to specific users
or user groups.Without views andmappings configured, all states in the workflow are displayed on the STEP
Workflow navigator tab (including parallels, clusters, and final states). When a workflow includes automated,
system, parallel, and/or cluster states, and users will be interacting with the workflow in the STEPWorkbench, it is
recommended to havemappings in place so that only the user states (e.g. states in which a humanmust interact)
are present on the STEPWorkflow tab.

Prerequisites
A workflow has been created and one or more views have been created for the workflow. This is required because
themapping task serves to connect any given view to a particular state or set of states. Therefore, for the exercise
to bemeaningful, both the view(s) and the state(s) must already exist. Also note that the viewsmust have an ID
assigned, else theywill not be available for selection in themapping. For more on creating views, see the
Configuring Views for Workflows topic.

Configuration
1. To addmapping to a view, right-click the editor panel on the left hand side anywhere, and selectAdd

Mapping.

2. In the right-hand panel in the View Editor window that appears, select the state from the dropdown for which
you want to apply a view.
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3. From the View dropdown, select the view that you would like to apply to the state.

4. Repeat the above steps asmany times as needed so that each state requiring human interaction has a view
assigned to it. Note that the same view can be applied tomultiple states.

5. Sequence themappings in the appropriate order by right-clicking on amapping and selecting 'Move Up' or
'Move down'. Sequencing of views is important as this defines the order in which the views are presented to the
user on the STEPWorkflow navigator tab. Mapping sequence is typically assigned alphabetically or
sequentially (e.g. the first state in the workflow is sequenced first).
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6. Save the workflow, exit the STEPWorkflow Designer, and go to theSTEP Workflow navigator tab.

7. Select the workflow for which view andmapping is being created and expand the flipper. When the flipper is
open for the workflow, only the states for which amapping was created are visible.

Workflow User / Group Specific Mappings
It is possible to createmappings that only apply to specific users or user groups. Themappings of a particular
workflow could be configured so that only users in a specific group can see a given state (e.g. only administrator
users have access to automated and system states to intervene in case of errors), or so that users in a specific
group could see taskswithin the same state with different views (e.g. an end user may need to see different data
than an administrator).

1. To create user / user group specificmappings, right-click the left panel in the View Editor, and selectAdd
Mapping Group.
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2. Select the user(s) and/or group(s) you want themapping to apply for. Note that there are separate fields for if a
group is added verses a single user.

If the Include all sub groups is checked, any subgroupswithin the group, aswell as direct users in the group
will have access to the view.
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In the example below, if the Include all sub groups option was checked and User Group was selected, this
would include User Group 2, its child User 3, as well as User 1, and User 2.

If theInclude all sub groups box is unchecked, only the top level users directly in the group have access to
the view. For example, with User Group selected, only User 1 and User 2 would have access to the view as
they are the only direct user children of the selected group.
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3. When all users or groups are added, right click on theMappings: empty node and selectAdd Mapping from
the context menu.

4. This will bring up the States and Views dropdownmenus to choose from (aswith configuring a standard
mapping). Select the appropriate state and view for the user or groups to have access to. Close the View
Editor and save the workflow.
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It is important to note that when a state ismapped to a view both inside and outside amapping group, and a user
logs in who is either directly specified on themapping group, or member of a group that is specified, themappings
will be evaluated from the top down and the first one that matcheswill be used. In other words, if the same user is
in two different groupswith different privileges, but both groups aremapped to the same state, then whatever
group comes first in themapping dictates the allowable privileges for that user. Thus, the order of mappings and
mapping groups is significant andmappingsmust be sequenced appropriately.
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Working with Tasks in Workflows
This set of topics focuses on the end-user, e.g. the user working with tasks in a workflow in the workbench, rather
than the user configuring and/or designing a workflow. After reading these topics, a user should be able to access
workflow tasks, edit data on objects in a workflow, and submit tasks through the assigned states in a workflow.

Topics covered in this section are:

l Moving tasks through a workflow

l The State Log tab

l Searching for tasks in a workflow

While concepts remain the same acrossworkbench andWebUI, the interfaces differ. For information specific to
WebUI, see theWorkflows in Web UI section of theWeb User Interfaces documentation.
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Moving Tasks through a Workflow in Workbench
In order to move an object or task through a workflow in workbench, it first must be initiated into the workflow. This
then allows the task to be addressed accordingly through each state in the workflow.

Should a user wish to initiate a task in a workflow inWebUI, seeMoving Tasks through a Workflow in Web UI
in theWeb User Interface / STEP Web UI Setup and User Guide documentation.

Initiating the Object into the Workflow
The below process describes how tomanually initiate an object into a workflow. However, it is important to note
that oftentimesworkflowswill be configured to automatically initiate objects of a certain type or types into the
workflow upon creation of the object. In addition, workflows can be initiated by a variety of other actions or
processes (both automated andmanually initiated), such as business rules, imports, or bulk updates.

Tomanually initiate an object into a workflow:

1. Navigate to the Tree tab and select the desired object. Right-click and select Initiate in STEP Workflow.
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2. In the dialog that appears, select which workflow to initiate the object into. Note that only workflows that the
object is valid for appear, and anyworkflows that are grayed out indicate that the object has already been
initiated into those particular workflows.
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If desired, the user can enter a ProcessNote when starting the workflow. This note is posted to the object's State
Log.

See theState Log Tab section of theWorkflows documentation for more information.

Processing Tasks in a Workflow
Once an object is initiated in a workflow, it is available in one or more states of the workflow. Each instance of an
object in a state represents a task to be completed. Each state is assigned to a particular user or group who has
the responsibility of completing the tasks in that state. Because of this, tasks aremost often accessed via the states
themselves, rather than via the objects in the states. The STEPWorkflow tab allows users to see tasks in the
states to which they have privileges to access. The Tasks tab on an object allows users to see all tasks for a given
object, acrossmultiple workflows. Both options are described below.

STEP Workflow TasksTab
STEP offers a task list in the workbench that shows all tasks assigned to the current user (either directly to the user
or to a group of which the user is amember). This is the primary interface for working with workflows in the
workbench and displays all workflows that the user has the 'View and use STEPWorkflow' privilege for. When
anyworkflow flipper is expanded, a list of the configured states is displayed, with an object count displaying the
number of tasks in the state that the user has access to.

Note that only tasks that are available for the user are displayed. For example, a user who is not part of a group
that can process tasks in the Review Data state will see a count of zero (0) rather than three (3).

Note: A legacy 'Advanced' subtab is available (in addition to the Tasks and Profiles tab shown in the above
screenshot). To see the tab, the user must have the 'View STEPWorkflow Advanced tab' privilege and the
configuration property 'STEPWorkflowNavigationXMLConfigurator.File' must point to a valid configuration file.
Such a file is included in the STEP distribution and is unpacked to "STEP_HOME/config-
examples/workflow/workbench-navigation.xml" when the application is deployed. If enabled, this tab lets users
search for specific tasks based on workflow, state, assignee and a set of configurable search criteria. The tab
gives access to see tasks assigned to other users and thus primarily should be used by administrators. Similar
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functions are available within the standard search functionality for workflow tasks, which honor privileges so it is
generally advised to use those instead. For more on using the Search tab see theWorkflow Search Criteria
topic. In addition, the Profile tab is used for monitoring workflows and is described within theMonitoring
Workflows section of theAdvanced Workflow Topicsmaterial.

To work with tasks via the STEPWorkflow tab:

1. Navigate to theSTEP Workflow tab, expand the flipper for the desired workflow, and select the appropriate
view. There are three options to choose from:

l Single user button: Only tasks assigned directly to the current user are displayed.

l Double user button: Tasks assigned directly to the current user or to a User Group of which he /she is a
member are displayed.

l Triple user button: All tasks are displayed. This button is only available if the user has 'STEPWorkflow
Administrator' privileges for the workflow.

Additionally, a user can further refine the task view by using the 'Filter by Collection' option. If a collection has
been previously set up, selecting that collection using the ellipsis button [...] will filter the task list to display only
tasks for objects contained in the collection. For more on creating collections, see theCollections
documentation.

2. With the appropriate view selected, click the link for the state in which tasks should be accessed. This will
display the tasks in the state according to the view configured by the workflow administrator, allowing users to
review and/or edit data as needed. Cells in yellow are read-only, while white cells can be edited. Red cellsmay
be present and are consideredmandatory and should be populated prior to submission, though the system
may or may not prevent transition of the task if they are not populated (based on how the designer has
configured the workflow).

Someworkflows require tasks to be claimed before they can be updated by a user. This can be verified by the
presence / absence of a task claiming icon ( ). If this is present in one of the columns on the STEP
Workflow Items tab, see theClaiming / Releasing Tasks in Workflows section of theAdvanced
Workflow Topicsmaterial for additional information.

Note: If it is preferred to see in the objects listed in columns instead of rows in the STEPWorkflow Items
editor, right-click the table header and select 'Rotate Table'.
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Note: The STEPWorkflow Items editor will as a default show amaximumof 100 tasks / objects when you
select a state on the Tasks sub tab. This limit can however be changed by a system administrator via the config
property "STEPWorkflow.Assignee.TaskList.Max".

3. Submitting a task to a subsequent state indicates that work on the task is complete. Unless the user has access
to a subsequent task for that object, it will no longer be accessible for them in the workflow. To submit a task,
select the task (multi-select is enabled using Ctrl + click), choose the appropriate selection from the dropdown
(if applicable) and click Submit. The available options for selection are configurable based on the design of the
workflow. In some cases only a single selection will be present and therefore it is not required for the user to
select a specific transition.

4. A dialog will appear, allowing the user to input a comment, which will be recorded in the Notes field on the State
Log tab of the object. Note that if multiple objects were selected, the same comment will be applied to all. From
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the dialog, click the Submit Now button to complete the task, or click Cancel to return to the STEPWorkflow
Items editor.

5. Clicking the Refresh button in the Task pane will update the task list.

Tasks Tab on an Object
From an object in Tree, the Tasks tab displays all tasks across all workflows for that object, subject to the user's
privileges. Only tasks that the user has rights to address are visible.

The interface and interactions are comparable to that of the task list, with the only difference being that users can
expand or collapse flippers to access tasks in various states and workflows.
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State Log Tab
Every type of object for which a workflow can be configured has an editor tab named State Log. This is useful to
aid with tracking the recent history of an object across all workflows on the system that include the object. Initiating
an object into a new workflow creates a flipper under which recent history is housed in accordance to that
particular workflow.

All transitions, assignments, and added noteswill be represented with an entry via a row in the table. For each
entry there will be a timestamp, a type (transition, assignment, or notes), and the name of the user causing the
entry. Note that only the latest 50 entries per workflow will show on the State Log.

Since entering and leaving parallels and clusters result in a lot of entries, it is possible to hide entries related to
entering and leaving states with these characteristics by checking theHide parallel and cluster box in the top
right of each table if desired. Furthermore, it is possible to toggle the three entry types (transitions, assignments,
and notes) on and off as well. For example, hide all the transitions and notes to only look at assignments.

Show Transitions: Is a log that gets recorded to display the “From” state to the “To” state of a Particular product
in a workflow. Upon having the checkbox “Checked”, it will display only the Transition state.

Show Assignments: Is a log that gets recorded to show the current user to whom the task has been assigned.

Show Notes: Displays if there are any notes that the user has entered while transitioning a product from one state
to another state in a workflow

Hide Parallel and Cluster States: If there are any states in a workflow which has Parallel of Cluster states, then
having this checkbox checked, will hide these states.

Note: Checkboxesmentioned above are nothing but a filter to format the view of state log. This allows a user to
view information which is necessary based on the requirement by checking or unchecking the checkbox.

Note: The log is not reset with every new workflow instance. Thus, if an object has been removed from a
workflow and then later initiated into the sameworkflow again, entries from the first instance will still be displayed.
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Workflow Search Criteria
The STEPWorkflow Search criteria lets a user search for:

1. Objects that are in a specific state in a specific workflow

2. Objects that are in a specific workflow but could be in any state

3. Objects that are valid for a given workflow, but are not in it

These options are helpful because they allow users to interact with workflowsmore efficiently. For example, if a
user wants to update a group of items that are already in a specific workflow, they can use search to identify the
items in a particular state and perform a bulk update on all objects. Additionally, if a user wants to see which items
are valid for a particular workflow and which have not yet been initiated they can do so. All of these options assist
users when working with workflows.

Performing a Search with Workflows
Below is an example of how the Search tab can be used for workflows.

1. Navigate to the side Search tab and click on it. A dropdown is present to specify search criteria.

2. Click on the dropdown and selectSTEP Workflow.
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3. When the STEPWorkflow criteria is selected, two parameters are available for a user to specify workflow and
state. A workflow must be selected, but selection of a state is optional. Also note the bracketed options in the
State parameter - allowing for users to identify all objects currently in the workflow, or all objects valid for the
workflow but not currently active in it.

4. When the options have been selected, click on Search to run the search and view any results.
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If a user is checking to see what tasks are in a state, they can also verify the results by going to the Tasks sub
tab in the StepWorkflow tab. See theMoving Tasks through a Workflow in Workbench section of the
Workflows documentation for more information.

5. If the search is not as refined as needed, a user can add additional search criteria by pressing the green +
button, , and further filtering the results. For example, the workflow criteria could be combined with the
Search Below criteria to isolate objects in a particular category.

For more information on the various search criteria and/or the actions that can be taken with a set of search
results, see theSearch Overview and child topics in theGetting Started / STEP User Guide documentation.
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Managing Workflows
When aworkflow is selected from the SystemSetup tab, various settings for the workflow can be viewed and/or
edited (if applicable) on the different tabs. These settings help in giving valuable information in regards to the
particular workflow such as an overview of the workflow, what the workflow is valid for, a list of users who have
interacted with the workflow or made changes, and any revision history.

To view the workflow tabs, go to SystemSetup, expand the workflows node, and select the relevant workflow.
This opens the workflow in an editor. Note that workflows viewed in the ApprovedWorkspaces are read-only.

STEP Workflow Editor Tab
The STEPWorkflow Editor tab displays basic information about the workflow, aswell as providing some global
configuration options for the workflow.

For more information on the basic settings, seeCreating a Workflow in theWorkflows documentation.

The STEPWorkflow Editor tab also has two flipper areas that show an overview of the business rules used in a
workflow: 'Used Local BusinessRules' and 'UsedGlobal Business rules'.

TheWorkflow Privileges flipper displays state-specific privileges for the workflow, which can be edited from the
Privilege Rules tab on a User Group, or from this interface. This functionality is useful when a particular user group
should have access to data only when an object is in the indicated state. For example, a user groupmay have
rights to edit certain data only when accessing the data from a particular state or an onboarding / creation workflow
or amaintenance workflow, but can only view the data for objects not in the editable workflow states.

To edit the workflow privileges, click on the Add Privilege link, and select the state that the particular privilege is to
apply to from the drop-downmenu in the pop-up window.
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Once the state has been chosen for which the privileges should be applied, it is then possible to set up the various
options to set the privileges for that particular state. Complete configuration information for workflow privilege rules
is provided in the Editing Privilege Rules section of the SystemSetup documentation.

Note that if workflow privileges are applied to a state, a 'P' indicator will appear on the state within the workflow
editor:

The Workflow Validity Tab
The Validity tab allows for specification of which object types the workflow is valid for. Only objects of the selected
types can be initiated into the workflow. Notice that while a workflow can bemade valid for multiple object types of
a specific node type, it cannot be valid for object types of different node types. For example, a workflow can be
valid for multiple types of entities, but not for both entities and classifications.
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The Workflow Log Tab
The Log tab is a list of dates and timeswhen changesweremade to the workflow. Listed with each time stamp is
the user whomade each change.

The Workflow Status Tab
The Status tab provides an overview of the revisions of the workflow, including the user who changed the object
and when the change occurred.
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Revisions are created when the workflow has had editsmade to it in the STEPWorkflow Designer, and the
designer is saved and closed. Minor revisions aremade automatically when various users interact with the same
object.

Major revisions can bemade on both the object initiated in the workflow or the workflow itself. It is recommended
tomake amajor revision for a workflow each time a set of changes has completed. For example, it may be useful
to make amajor revision when UAT begins for a workflow so it is clear what is being tested, and again upon
completion of UAT so that it is clear what has been released for production. To do so, click on the workflow in
SystemSetup, and select Make Revision from theMaintain menu.

Previous versions of STEPWorkflows can be viewed by selecting the revision on the Status tab, right-clicking on
the row indicator (>), and selecting View STEPWorkflow.
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Revert to a previous revision
From the Status tab, it is possible to revert to a previous revision of a workflow by right-clicking on the row indicator
(>)of the workflow that should be reverted to and selecting 'Revert to'.

When reverting to a previous version of a workflow, any local business rules owned by the workflow in question
will also be reverted to their past states. Note that when a 'Revert to' option is selected, it will create a new revision.
Additionally, in the comment column an automatic comment stating which revision that object has been reverted to
will generate.

Purging Workflow Revisions
Any revision can be purged, but once a revision is purged it cannot be recovered.
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Note: Purging of previous revisions has to be considered carefully. Reverting to a previous revision of a workflow
that is dependent on a purged revision of a business rule is not possible. Purging is per default limited to a certain
object, not a set of objects.

To purge a revision, right-click on the row indicator (>) next to the desired revision and select Purge.

For more information on the Status Tab and revisions, seeManaging Revisions in STEP in theSuper User
Guide / System Setup documentation.

Deleting Workflows
To delete an entire workflow, right-click on it from the SystemSetup tab and select Delete.

Deleted workflowswill be available in the SystemSetup Recycle Bin until they are purged (permanently deleted)
or revived (restored to their previous location).
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Advanced Workflow Topics
This portion of thematerial coversmore advanced workflow configurations, going beyond the basic setups
described in the introductorymaterial. Users should be familiar with all material in theGetting Started with
STEP Workflows documentation before attempting to configure and/or utilizemore advanced workflow
functionality.

Most real-world workflowswill utilizemany of the functions described in the advanced topics, but none are
required in any particular workflow. The topics generally do not build on one another and completing one
configuration typically does not require knowledge of any other, outside of the basic workflow setup.

In other words, the advanced workflow documentation is function and topic based, meaning that each topic
describes a particular function a user maywish to carry out (e.g. send email from aworkflow or remove objects
from aworkflow) or a particular topic a user maywish to read about (e.g. workflow attachments or workflow
deadlines).

Therefore, there is no suggested reading order and users should approach thematerial in the order that seems
most relevant for their workflow.
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Assignees in Workflows
In workflows, an object cannot be in a state without an assignee being set. This regardless of whether the state
represents a human task or not. The assigneemust be an existing STEP User or user group.

An important thing to notice when working with assignees is that users who do not have the 'STEPWorkflow
Administrator' privilege for a given workflow only will be able to see tasks assigned to themselves or a group they
are amember of. Furthermore, theywill only be able to work with tasks assigned directly to themselves and have
to claim a task (i.e. assign it to themselves) to be able to edit workflow related data and perform transitions. Users
with the 'STEPWorkflow Administrator' privilege can view and work with all tasks regardless of who they are
assigned to.

Note: For states that do not represent a human task, you will typically want the assignee to be either an
administrator with in-depth knowledge about the workflow or a dedicated 'automation' dummy user.

There aremultiple ways of setting the assignee for a state. In the sections below the options in theWorkflow
Designer State Editor are described.

For setting the assignee using theOn Entry tab in the State Editor, see theAssigning Tasks Using Business
Rules topic in the AdvancedWorkflow Topics section of theWorkflows documentation.

For more on retrieving user IDswhowork with tasks in workflows, see theRetrieving the ID of an Assignee
Completing a Task in a Workflow in the AdvancedWorkflow Topics section of theWorkflows documentation.
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Assigning Tasks Using Business Rules
While the assignee alwayswill be set using the option selected on the State Editor's Assignee tab when entering a
state, it is sometimes necessary to overwrite the assignee using a business action configured to run in the State
Editor on theOn Entry tab.

Overwriting the Assignee in Workflows with JavaScript
If the user has the ID of an assignee in a workflow variable, it is of course recommended that the user use the
'Fetch fromVariable' option described in theWorkflow State Editor Assignee Tab Option section of the
Workflows documentation. If however the user wishes to do it with a script On Entry, it can be done with the
following script, given "WorkflowVariableHoldingID" holds the ID of a STEP User:

var instance = node.getWorkflowInstance(workflow);

var userObj = step.getUserHome().getUserById(instance.getSimpleVariable
("WorkflowVariableHoldingID"));

instance.getTaskByID("MyState").reassign(userObj);
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A user should have STEPWorkflow Administrator privilege to use this 'reassign()' API method, however only if the
'Use executing user's write privilege' option on theWorkflow Object editor is selected.

Reassigning to Previous Users in a Workflow
If a task is rejected back to a previous state, and needs to be worked on by the same user who initially worked on it
in that particular state, this business rule can be used in combination with On Exit actions to return the correct
assignee.

In the example below, a user picks up a task in the Edit sate, completes the assignment and submits it to the
Review state. AnOn Exit business action is in place on the Edit state to store the data of who last worked on the
task in a workflow variable. For more about On Exit scripts seeRetrieving the ID of an Assignee Completing
a Task in a Workflow in theWorkflows documentation.
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Once in the Review state, a different user looks at the task and does not think it is ready tomove forward. They
sends it back to the Edit state to be re-evaluated by the user who originally submitted it.

To do this On Entry action of overriding the workflow default assignee back to the user who originally worked on it
in the Edit state, the following script with the corresponding binds need to be put in place:
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For the script below, note that where it says "MyState", the user should populate this with the ID of the state the
script is being put on. Additionally, where it says "WorkflowVariable" this should be populated with the necessary
workflow variable for the user's particular workflow.

var task = node.getWorkflowInstance(workflow).getTaskByID("MyState");

var reassignUser = node.getWorkflowInstance(workflow).getSimpleVariable
("WorkflowVariable");

if(reassignUser!=null) {

var user = manager.getUserHome().getUserById(reassignUser);

if(user!=null){

manager.executeWritePrivileged(function() {

task.reassign(user);

} );

}

}
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Retrieving the ID of an Assignee Completing a
Task in Workflows
In a workflow, it is common to havemore than one user interact with different tasks in a particular state. As a task
progresses through the workflow, it is then helpful to know which user last interacted with the task. To help with
this, there is an automated process that can be set to retrieve the ID of the last assignee to a task. This way, should
there be an error with the task and it needs to be sent back to the previous state, it can also be determined on who
the last user waswhile in that state.

There are two script options that can be used according to user preference. Both are placed on a State Editor on
the 'On Exit' tab. Both scripts can also be combined with a condition to guarantee the user ID is returned, if
desired.

Using Manager Interface to Return the User ID in a Workflow
In the script below, the ID of the user who performs the transition is obtained via theManager interface ("step" is a
shorthand for getting theManager). This script retrieves the ID of an assignee and stores it in a workflow variable
which is being represented by "WorkflowVariable" in this case.

var assigneeId = step.getCurrentUser().getID();

node.getWorkflowInstance(workflow).setSimpleVariable("WorkflowVariable",
assigneeId);

For the example below, the workflow variable is called 'MyVariable'.
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To implement this, open up the desired workflow, right-click on the desired state and select Edit state > On Exit >
Add new Business Action > Merge into > Execute JavaScript. Add any necessary binds for the workflow.

One aspect to be aware of is that a user with the 'STEPWorkflow Administrator' privilege potentially could have
completed the taskwhile the workflow was assigned to a group, resulting in the group ID being returned instead.
Use the conditionmentioned at the end of this topic if returning the user ID only for the workflow variable is a
concern.

Using Task Interface to Return the User ID in a Workflow
Alternately, the ID of the Assignee can also be obtained via the Task interface. This too is implemented by opening
up the desired workflow, right-clicking on the desired state, and selecting Edit state > On Exit > Add new Business
Action > Merge into > Execute JavaScript. Again, replace "WorkflowVariable" with the variable for the workflow,
and add any necessary binds for the workflow.

var instance = node.getWorkflowInstance(workflow);

var assigneeId = instance.getTaskByID("MyState").getAssignee().getID();

instance.setSimpleVariable("WorkflowVariable", assigneeId);
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Again, an aspect to be aware of is that a user with the 'STEPWorkflow Administrator' privilege potentially could
have completed the taskwhile the workflow was assigned to a group. This could result in the ID of a user group
being stored in theWorkflow Variable, versus the individual user ID.

For this reason, adding a condition on the transitions out of the state in conjunction with the script on the Task
interface will guarantee that the ID stored in the variable will be an individual user and not the group ID.

Condition to Aid in returning User ID in Workflows
Below is the condition that can be added to the Transitions Editor on the 'On Transition tab' out of the state that is
retrieving the user ID. This condition in conjunction with the script, will make it impossible for a task to exit the state
if the assignee is a group ID. To implement the condition, right-click on the transition > Edit Transition > Condition
> Add new BusinessCondition > True if value for Attribute"" "null" > Execute JavaScript. Add any binds needed
for the workflow.

var instance = node.getWorkflowInstance(workflow);

if(instance.getTaskByID("MyState").getAssignee() instanceof
com.stibo.core.domain.Group) {

condition = false;

resultMessage = "Please claim the Task before submitting.";

}

else {

condition = true;

}
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If a user wishes to send a task back to a previous state and re-assign it to the user who worked on the task in that
state, please seeAssigning Tasks Using Business Rules topic in theWorkflows documentation.
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Workflow State Editor Assignee Tab Options
Every state in a workflow needs an assignee in order for the workflow to work. An assignee can be set for any
state by opening the State Editor and navigating to the Assignee tab. On the State Editor's Assignee tab the
following options for setting the Assignee are available:

Workflow Default
If this option is selected, the state will get the assignee specified as the default for the entire workflow.

The originalWorkflow Default for the entire workflow is specified by right-clicking the canvas and selecting 'Edit
Workflow', by double-clicking the canvas, or by double clicking the header bar showing theWorkflow ID/Name. As
the user will notice, in the dialog that appears on the Assignee tab, it is not possible to select the 'Workflow Default'
option. This is because a user or user group needs to selected in order for there to be a default option for any
states in the workflow.
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While the user does not necessarily have to specify a default assignee for the workflow, if any of the states are
configured to use it, the workflow will not save until aWorkflow Default assignee is established.

Select User / Group
Use this option to pick a specific user or user group to function as the assignee.

Fetch from Variable
Using this option it is possible to set the assignee based on the value of aWorkflow Variable. When an object is
transitioned into a state with this setting, the variable valuemust hold either a STEP URL for a user or a user
group, or the ID of a user or user group (If there is a user and a group with the same ID, the user will be selected).

If STEP cannot find a valid assignee from the variable value, the transition into the state cannot be performed and
the user will get an error. As the 'Fetch fromVariable' option requires aWorkflow Variable to be set before
entering, it is not available when setting the workflow default and neither is it available for Initial states not inside
clusters.

The variable to read the assignee from could be populated by the 'WorkflowVariableUserList' view component
(see theViews and Mappings for Workflows section of theWorkflows documentation) or could be set in a
business action. An example could be when leaving a state, the assignee for that state is stored. SeeRetrieving
the ID of an Assignee Completing a Task in a Workflow in theWorkflows documentation for an example.

Executing User
Using this option will set the assignee to be the user who performs the transition into the state. Typical use case is
when the individual who created the workflow wants the user who starts a task in the workflow to become the
assignee for the first state. Beware of the fact that if the option is selected for the entire workflow, the user will be
resolved each time a state configured to use theWorkflow Default is entered. That is, for each state the assignee
will be set to the user performing the transition into the state, not the user who originally started the workflow.
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Advanced Options
Via the Advanced button on the Assignee tab it is possible to let the assignee be set by an assignee Provider
plugin. These plugins can be customer specific but three are present in the STEP core:

Component Returned Value

SupplierLinkAssignee Provider plugin for getting a supplier group assignee via a classification link. Only
works for products.

SupplierAssignee Legacy version SupplierLinkAssignee.

VariableAssignee Legacy version of the 'Fetch fromVariable' option described above.

Note: The assignee provider plugins generally require that one of the above three default options is selected. This
selection will then be used as a fallback if the plugin fails in delivering a valid assignee.
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Claiming / Releasing Tasks in Workflows
As noted in theConfiguring Views for Workflows section of theWorkflows documentation, when using the
WorkflowTaskColumn View Component, it is possible for users to claim and release tasks directly from the STEP
Workflow Items editor or the object's Tasks tab. This is important because it allows users to 'check out' a task to
work on, thus preventing other users from taking the task and working on it as well.

For example, when a user clicks the icon in the column labeledWorkflowTaskColumn on a task assigned to a
group, in doing so the user has now assigned the task to themselves and opens it for editing.

This implicitlymakes the task invisible to the other users in the group, assuming that they do not have the "STEP
Workflow Administrator" privilege.

For normal users that do not have a special 'STEPWorkflow Administrator' privilege, the following apply:

l The users can only see tasks assigned to them or a user group they are amember of

l The users can only complete tasks assigned directly to them

l The users can only edit workflow specific data for tasks assigned directly to them

It is important to notice that an object will not be locked when it is active in a workflow. That is, if a user normally is
privileged to edit an object, the user can still do this regardless of how many different flows the object is active in.
Thus, the assignee related restrictionsmentioned above only apply to workflow data and functionality.

When a task is claimed, it is possible to release it again, assigning it back to the latest 'Group Assignee'. If the task
has never been assigned to a group, the task is assigned to the default assignee for the state.

Both the claim and release operations are also available through the API Task interface (Task.claim() and
Task.unclaim()).

Claiming a Task in a Workflow
In the following user group, there are two users, User L and User M.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 104



User L signs in, opens the workflow, and navigates to the state where he / she can claim tasks. In this case it is the
Review Data state.

Note: Should a task be initiated into a workflow by a user, the taskwill be assigned to the User Group in which the
current user resides.

For User L to claim the state, they click on the Claim icon, , claim the task, , and the assignee automatically
changes to the user who has signed in, in this case User L.

Once a task has been claimed, it is no longer visible to other users in the same user group.

Releasing a Task in a Workflow
To release a task, click on the Release icon, , and the Claim icon, , reappears. The Assignee column
changes back to the user group the user is a part of, and another individual in the same user group can now see
the task and claim it if needed.
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Workflow Re-assignments
Sometimes it is necessary for an individual user or user group to be assigned a task in a workflow to complete
before the task canmove on to the next state. For example, a taskmay be assigned a 24 hour deadline to be
picked up by a particular user. If the task is not picked by the user in that time period, then a business rule can be
configured in such a way that when the deadline ismet, either an email can be sent to amanager to re-assign the
task to other user in the user group, or it can be programmed to automatically assign the task to a different user in
the group.

Re-assignmentsmight also be helpful if a task needs to be reassigned from one user to another user when a task
moves from one state to the next.

There are two ways that a re-assignment of a task can take place. Re-assignments can be performed by a user
with the STEPWorkflow Administrator privilege either from view andmapping via the 'WorkflowAssignee'
Component or via the API Task interface (Task.reassign(assignee)).

Users without the STEPWorkflow Administrator privilege will only be able to complete and edit workflow data for
tasks assigned directly to them. Thus if a task initially is assigned to a user group but a user needs to work with it,
the user must be provided with an option for claiming the tasks, and reassigning it to themselves.

For tasks handled in workbench, a special task view component called 'Workflow TaskColumn' exists for this
purpose. The component lets users claim a task and also assign it back, or release it, to the initial group assignee.
More information about this is provided in theClaiming / Releasing Tasks in Workflows topic in the
Workflows documentation.

Discussed below is the setup for STEPWorkflow Administrators to performwhen configuring re-assignment via
the views andmappings option.

For more on API task re-assignment see the STEP API documentation.

Administrator Privilege Setup for Workflow Assignee
For a user with STEPWorkflow Administrator privilege to assign the tasks to different users in a user group, the
component 'Workflow Assignee' should be added in the view andmapped to the required workflow state.
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For more on views andmapping seeViews and Mappings for Workflows in theWorkflows documentation.

1. Navigate to SystemSetup and select the desired workflow. Right click the workflow and select Edit STEP
Workflow > Edit Workbench Views and Mappings.

2. Right click the view that needs assignees and select Add Column > AddComponent >WorkflowAssignee.

3. Add any user groups and Users to the component as needed, and title appropriately.
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It is important to note that if the option ‘ReadOnly’ is checked then theWorkflow Assignee columnwill be un-
editable, and the user with STEPWorkflow Administrator privilege will no longer be allowed to assign the task to
other users.
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Re-assignment Procedures for STEP Workflow Administrators
To assign a particular task to a user, the user with STEPWorkflow Administrator privilege can do somanually on
the STEPWorkflow tab and the object's Tasks tab, or by creating a business rule. For task reassignment using
business rules, please refer to the documentAssigning Tasks Using Business Rules in theWorkflows
documentation.

STEP Workflow Tab
1. Go to STEPWorkflow Tab and select the relevant workflow.

2. Click on the particular state in the workflow, and navigate to the 'Assignee' column in STEPWorkflow Items
tab.

3. Once on the 'Assignee' column, click on the dropdown so that assigned user will be visible.

Select the user from the dropdown in parallel with the task to be assigned.
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Object's Task Tab
Similarly to how an assignment to a user is performed on the STEPWorkflow tab, a task can also be assigned on
an object's Tasks tab.

1. To do so, click on the object and navigate to the Tasks tab.

2. Once on the tab, locate the workflow the object is in that needs a task assignment. Select the user it should be
assigned to from the 'Assignee' column.
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Auto-Initiation of Tasks in Workflows
Auto-initiation is used to automatically initiate an object / task into the desired workflow when it is created or on-
boarded, otherwise this would need to be donemanually. With auto-initiation, items are able to be pushed through
automatically, making it much simpler andmore time effective.

Two commonly used scenarios where auto initiation is often applied are:

1. Once a user creates an object in workbench or WebUI, the object can be initiated automatically in the specific
workflow.

2. When new objects are imported, the object can be initiated automatically in the specific workflow.

For example:

If a workflow is valid for Products, Classifications, Assets, Entities, Publications, Publication Sections, or
Flatplanner Planned Pages, it is possible to have an instance of a given workflow created whenever an object of
the valid object type(s) is created. In other words a workflow is automatically started when the object is created.

Setting up Automatic-Initiation of Tasks in Workflows
1. To set up automatic-initiation, select the system setup tab and expand the folder that housesworkflows.

2. Select the desired workflow, in this case Shipment Oder Processwill be used, and place a check in the 'Initiate
automatically' checkbox on the STEPWorkflows Editor tab.
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Now whenever an object of a type valid for the workflow is created, a workflow will be started. This could happen
via workbench,WebUI, web services, or through an import.

Initiating an Object Automatically in Workflows
It is important to know before creating an object, what the desired workflow is valid for, otherwise the object will not
be able to automatically initiate. To check validity type, this can be viewed by opening the workflow and selecting
the Validity tab. In this case, Shipment Order Process is valid for products that have an object type of the following:

Note: Object types / nameswill vary according to user setup.

Create and Initiate from Workbench
Once the validity type is verified, a product can be created in the workbench by entering an ID and name.

For more information on creating new objects see theCreating Objects in Tree topic in theUser Guide /
Getting Stared documentation.

There are a number of ways to verifying that the product was automatically initiated into the desired workflow. A
few are:
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l On the search tab, search the workflow tomake sure it was initiated automatically

l Navigate to the STEPWorkflow tab, open the workflow, and check to see that it appears in the first state in
STEPWorkflows Items tab.

l Navigate to the items Task tab and check to see that it appears in the desired workflow.
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Create and Initiate from Import
Another way to create and initiate objects into a workflow automatically is to do so via an import, where product
information, such as that below, is uploaded to STEPWorkbench.

Tomake sure that items automatically initiate upon import, in the Import Manager wizard, under 'Advanced
Settings' make sure thatAuto-Initiate STEP Workflow on Item Creation is checked. If this is not checked, the
itemwill not automatically initiate.
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When the import is run, a background process is created and the user can see the product(s) initiated into the
workflow in the background process.

For more details on the Import Manager Functionality and the Import Manager wizard, see Creating a Data
Import in theData Exchange documentation.

However, if a user has the 'Disable STEPWorkflow Auto-initiation in Imports' privilege for a workflow, he/she is
allowed to disable auto-initiation in the Import Manager (column based Imports) or directly in the XML for XML
imports (by setting AutoInitiate="N" in the STEPProductInformation tag).

Note: If an object has been put into the Recycle Bin (and thus taken out of anyworkflow) and is revived, it will be
initiated in the workflowswith auto-initiation turned on.
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Auto-Routing Tasks in a Workflow
In workflows, theremay be caseswhere the system (via business rules) shouldmake the decision for the path a
task takes through the workflow, rather than a user. While there aremany use cases for this, a simple scenario is
the 'if X, then Y' reasoning. For example, a user may have a workflow set up that evaluates each product that
passes through a particular state to see if there is lead in it. If so, special handling instructions need to be applied,
whereas this is not required for items that are lead-free. Therefore, tasks are automatically routed to differing
states based on the presence / absence of lead, which is determined by an attribute value.

This topic describes the preferredmethod for basic auto-routing of tasks, and allows for users to submit a task
without requiring any knowledge of where it needs to go next, as this is evaluated and determined via a series of
conditions on the available transitions. There are additional methods available for auto-routing of tasks, including
via use of the Scripting API Task interface and the triggerByID() and triggerLaterByID() methods.

Auto-routing using conditions requires that all transitions from the state have the same event name applied. It is
also important to remember that all conditions return either true or false, and that a condition evaluating to true on
a transitionmeans that the transition can be taken, while a condition evaluating to falsemeans that the transition
cannot be taken.

This setup can be used to skip states, as well as to select between one of two states. Therefore, either of the below
workflows could utilize it, and in both cases the outcomewill be that the task is sent to the Has Lead state from the
Review Data state, if needed. Note that in all cases, all transitions out of the Review Data state have the Proceed
event. With this setup, the end user will see only a single selection option (Proceed) when submitting the task,
allowing the system tomake the decision, while keeping things simple for the end user.
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In order to determine where the task should go, an attribute with ID=HasLead is evaluated. If the value is Yes, the
taskmust go to the Has Lead state. If the value is No, the taskmust take the other transition. We could set up a
"Yes" condition and a "No" condition, applying one to each transition out of the state as appropriate, and that would
accomplish the end result. However, if an object did not have the HasLead attribute populated, it would not have a
viable transition, unlesswewrote a condition to account for a null value. Assumingmandatory attribute
functionality was applied and we could ensure a value was present, there is however still an easier way to do it
using only a single condition, which evaluates to true if HasLead=Yes. By leaving another transition with no
conditions applied, and instructing the system to always evaluate the conditioned transition first, all taskswith the
Yes value are caught first and appropriately routed, and all taskswith a 'No' or null value take the other
(unimpeded) option.

Detailed instructions and additional considerations for this setup are below.

1. Set the order in which outgoing transitions are attempted by right-clicking on the state that has themultiple
transitionswith the same name coming out of it, and selectingEdit Order of Outgoing Transitions.

2. In the dialogue that appears, select any entry and use theMove Up orMove Down buttons to set the
appropriate order. Note that the example uses only two transitions, but thismethod works for any number of
transitions. The '0' transition is evaluated first, and subsequent transitions are evaluated in sequential order.
The systemwill send the object via the first transition it finds that evaluates as true.
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If multiple transitionswill exist with conditions applied, care should be taken to ensure that they are sequenced
properly, that they do not overlap unless intended (andmanaged via sequencing), and that all tasks have a
way to exit the state. With that in mind, it is generally advised to ensure that conditions are exclusive (e.g. a task
is not likely to evaluate true for more than one transition), and that one transition exists unimpeded (e.g. without
a condition). However, there are of course exceptions to each of these advisements so a better one is simply to
put careful thought and testing into the design and outcome.

3. Set a condition on the transition to be evaluated first. For the purposes of the example, a basic attribute value
comparison will be done, but any condition could be used. Double-click on the order zero transition to open the
Transition Editor. Select theCondition tab and click theAdd new Business Condition link. Click theEdit
icon to open the Edit Operation dialog and selectAttribute Value Comparison from the dropdown. Select
the appropriate attribute, operator, and value. ClickSave to close the Edit Operation dialog, and click the [X] in
the upper right corner to close the Transition Editor.
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Bulk Update Operations for Workflows
The STEP Bulk Update operations is an efficient way of updatingmultiple objects in a single operation. For
workflows it can be used to claimmultiple objects in a specific state in a specific workflow, initiate multiple objects
into a specific workflow, removemultiple objects from a specific workflow, or trigger a specific event for multiple
objects in a specific workflow.

For more on bulk updates see theBulk Update Operations topic in theBulk Updates documentation.

The table below defines how each operation is expected to perform. Additionally, the next proceeding sections of
this document will explain how each operation worksmore precisely.

Operation Description

Claim Assigning a workflow task to a specific user

Initiate items in STEPWorkflow Bulk update is performed on the objects to initiate them into a selected
Workflow.

Remove items fromSTEP Removes all objects from the selected workflow.
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Operation Description

Workflow

Trigger STEPWorkflow Event Triggers a selected workflow event.

Claiming a Task in a Workflow
The 'Claim' bulk update operation allows the user to claimmultiple tasks in a state at one time. For example, if
there are 10 tasks in one state, instead of a user having navigate to the STEPWorkflow tab, opening up the
desired workflow and clicking each individual task using the claim button, , in the STEPWorkflow Items tab, a
user can claim all the tasks at once using bulk updates.

Claiming a Task
To claim tasks, the following steps need to be followed by the user who wishes to claim the tasks. In this case it is
User L.

1. It is important to check andmake sure that the tasks are initially unassigned to any user in a state.

2. Once verified that they are unclaimed, go to the Search tab, and select STEPWorkflow from the dropdown.
Next select the desired workflow and state to display the objects present in that particular state, and click the

bulk update button, .
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This will create a bulk update for all of the objects in that particular state. Additionally, it is also possible to save the
search results as a collection, and schedule a bulk update by selecting the saved configurations. Note that this also
saves all tasks that show up in the sate in the collection.

Note: If a user wishes to only claim certain tasks that show up in the search, they should press 'control' and select
the desired tasks. Then instead of pressing the bulk update button at the bottom of the search, a user should go up
to File > Bulk Update > Run Bulk Update.
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3. Select the workflow and the state from the dropdown.

4. Navigate through the succeeding windows, and click on Finish.
5. A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.
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6. If the BGP was successful, navigate to the STEPWorkflows tab again and check to see that the items are now
claimed and assigned to the appropriate user, in this case User L.
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Initiate Items in STEP Workflows
Whenever new objects / products / items / or tasks are created or on-boarded, it has to be processed via the
workflow. Instead of initiating each item individually, a user can save time by initiating them all at once in a bulk
update.

How to Initiate Tasks in STEP Workflow Using Bulk Updates
The following steps are required configurations to run a bulk update. It is important to keep inmind that a workflow
needs to be valid for the objects / products / items / tasks being initiated into it.

1. First search for the products that are to be initiated into the desired workflow and select the button for a bulk
update.
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Alternatively, you could click on the objects in tree and go up to File > Bulk Update > Run Bulk Update.

2. In the Bulk Update wizard that appears, navigate to the Operationswindow and select Workflow > Initiate
items in STEP Workflow. Select the correct workflow from the dropdown, and add a process note if desired.
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3. Navigate through the succeeding windows, and click on Finish.
4. A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.

5. If the BGP was successful, navigate to the STEPWorkflows tab again and view the items that were initiated in
the workflow. The assignee of all of these itemswill be the user who is logged in and performed the bulk
update.

Removing Items from STEP Workflow
Should a user want to remove all objects from one state in a workflow, they can do so using bulk updates if they
have the ability to search the STEP workflow tab, and they have the 'PerformBulk Update' privilege.

For complete directions on how to use bulk updates to remove items fromSTEPWorkflows, see theRemove
Objects From Workflows topic in theWorkflows documentation.

Trigger STEP Workflow Event
This function is useful when a user completesmultiple tasks and needs to trigger multiple tasks from one state to
another at one time

How to Trigger STEPS Workflow Events
For example, if a workflow has a state called ConfirmData with 7 tasks in it that all need to bemoved to the next
state, called Approve Data, the user would follow the steps below to perform this action.
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1. First go to the Search tab, and select STEPWorkflow from the dropdown. Next select the desired workflow

and state to display the products present in that particular state, and click the bulk update button, .

2. In the Bulk Update wizard that appears, navigate to the Operationswindow and select Workflow > Trigger
STEP Workflow Event. Select the correct workflow, state, and event to be performed. Add a process note if
needed (process notes are the information for the users in the next state.).

© Stibo Systems - Confidential - STEP Trailblazer 8.1 128



3. Navigate through the succeeding windows, and click on Finish.
4. A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.

5. If the BGP was successful, navigate to the STEPWorkflows tab again and view the items that weremoved
from one state to the next in the workflow.

Note: If the Bulk Update is run on objects not in the specified state in the specified workflow, warningswill be
generated in the Bulk Update Background Process and the objects left unchanged.
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Business Rules in Workflows
Whenworking with workflows, it is very common to use business rules. They can help with a number of functions,
such as sending email, validating data, moving a task through a workflow, assigning tasks in a workflow to
particular users, amongmany other actions. It is important to know that business actions can take actions in a
workflow, while business conditions are able only to check and/or validate data.

This topic provides a general introduction to some overall functionality specific to business rules in workflows.
Muchmore information regarding business rules in general (applicable to rules used both within workflows and
external to workflows) is available in the generalBusiness Rules section of the documentation.

A Simple Example
Below is an example of how a number of business rules can work together to make a coherent and functioning
workflow. It is possible to define business actions to be executed as part of the workflow on states or transitions,
and to define conditions to be tested before transitions between states are performed.

For example, a company needs a number of documents signed and agreed upon before they can proceed with
their new business partners. In order to make sure that the documents were reviewed and signed to exact
specifications, the workflow above was created to help with the process.

For this workflow a document, or task, enters into the Start state where it is picked up by an assigned user, .
After all assignments are completed they submit the task to the Edit state. Here a user claims the task, completes
any assignments regarding the task on time, , and then submits it to the Review state. As they submit it to the
Review state, a business rule captures the ID of the user who submitted the task, .
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Once in the Review state, a new user claims the task. If however, they do not think that it is ready for review, they
have the option to send it back to the Edit sate. If they choose to do this, as the task enters into the Edit state again,
there are business rules in place to send the task back to the user who originally worked on it in this state, , and
sends them an email to notify them it was rejected back to them.

However, if the task enters the Review state and the user who picks it up does think it is ready to be delivered, they
can choose to accept it, and submit it to the Done state. Notice that a condition is in place on the transition from the
Review State to the Done state. This conditionmakes it so that the reviewer has to populate an attribute field on
the task called 'Approved' to 'Yes' in order for it to be submitted to the Done state successfully.

A few aspects to note:

l If a script exception is thrown during the transaction, or the assignee for the Edit state cannot be set, the
entire transaction including any changesmade is rolled back

l When theOn Transition Action is executed the task is not in any state, any attempt to manipulate a taskwill
cause an error to be thrown, and again the transaction will be rolled back

Applying Rules in a Workflow
Business actions can executed fromworkflow states at three points:

1. Entering a state (On Entry)

2. Exiting a state (On Exit)

3. As part of an escalation when a deadline for a state has beenmet (seeDeadlines and Escalations inthe
Advanced Workflow Topics documentation for more details).
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Business actions can also be executed on transitions between states:
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Business conditions can be executed only on transitions:

Regardless of the place the rule is applied, or whether it is a condition or an action, a few things are common to the
editors (and specific to the business rule editors within workflows).

A business rule can be added to a workflow by using the ellipsis button [...] to select an existing rule (1), or by using
theAdd new Business Action /Add new Business Condition link (2).
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Defining a new business rule fromwithin the STEPWorkflow Designer, creates a local business action (2), while
selection of an existing rule (1) allows users to choose from global rules.

Important: Local business rules can only be used in the workflow where theywere created.

If a rule could be re-used inmultiple locations, it is generally better to create it as a global rule.

If a local rule has been created, it can be promoted to a global rule using the hand icon . This creates a global
copy of the rule so that it can be used elsewhere.

If a global rule is selected, it can be edited using the edit icon , though care should be take with this as it results

in changing the rule in all placeswhere it is used.

If a global rule should be changed, it is often better to make a local copy of the rule using the copy button ,
ensuring that any changesmade to the rule will only affect the current workflow.

Local business rules created or edited through the STEPWorkflow Designer are saved when the workflow is
saved. Global business rules are saved when changes are saved within the business rule editor.

Workflow Business Rules in Operation
Each time a business action or condition is configured on a state or on a transition, the workflow has indicators to
signal to the user where these business rules have been applied. The indicators are the following:

Indicator Description

'A' A default assignee for a particular state (or workflow) has been assigned.

'D' A default deadline has been selected.

'I' Signals the configuration of an 'On Entry' action. It may help to remember this as 'I' for
'In' (e.g. into the state).

'O' Signals the configuration of an 'On Exit' action. It may help to remember this as 'O' for
'Out' (e.g. out of the state).

dotted transition
line

Indicates a condition has been placed on the transition.

rounded end on
transition

Indicates an action has been placed on the transition.
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Order of Operation
It is important to note the order of operation of the various rule types (condition or action) and where they are
applied (entry, exit, transition, or deadline). Consider an object going from a current state to a next state. Business
rules are evaluated in this order:

1. Condition on transition exiting current state

2. On exit action from current state

3. On transition action between current and next state

4. Default assignee on entry to next state (if assignee is set in workflow designer rather than using business rules)

5. Deadline set in next state

6. On entry action in next state

More Information
This topic has provided a basic introduction to how business rules can be used in conjunction with workflows.
Topics covering how to carry out all of the functions described in the above example can be found throughout the
Advanced Workflow Topics section of the documentation, in addition to other use cases and topics, including:

l Assigning TasksUsing BusinessRules

l Auto-Routing Tasks in a workflow

l Configuring Status Flags in workflows

l Deadlines and Escalations in workflows

l e-Signature used to re-authenticate in a workflow

l Java API for workflows

l RemoveObjects fromworkflows

l Running Background Processes fromworkflows

l Send Email from aworkflow

l Validate Data in a workflow

As business rules provide robust functionality to meet the individual needs of each customer, it will also be useful to
see the generalBusiness Rules section of the documentation to understandmore advanced features, as well as
the Scripting API section of the STEP API documentation.
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Deadlines and Escalations in Workflows
In theWorkflow Designer a user can define a deadline for a state via the State Editor Deadline/Escalation tab.
This is useful for a number of reasons, one of whichmight be to notify a supervisor, or taskmanager, if a deadline
is not met for a particular task in a particular state. Thismay be important to know because if the task is late, it could
impact many steps that come after it.

Understanding Deadlines in the Workflow State Editor
Here the deadline is set relative to the time an object enters the state. For example, if it is set to '5 Hour(s)' an
object entering the state at 6 a.m. will get the deadline set to 11 a.m. The available time periods are: Hour(s), Day
(s), Work Hour(s), andWorkDay(s). Work hours are hard-coded to be from 8 a.m. to 4 p.m., with work days being
Monday to Friday (bank holidays and the like are not taken into consideration).

Setting up Deadlines for Workflows
1. In SystemSetup, navigate to the desired workflow, right-click on it and select Edit STEPWorkflow

2. Right-click on the desired state and select Edit State.
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3. In the new dialogue, select the Deadline/Escalation tab.

On the same tab it is possible to define or select a business action that should be executed if the deadline ismet
and the background process for monitoring deadlines is run.

This background processwhich of course can be scheduled to run with specific intervals can be started from any
SetupGroup in the SystemSetup that can hold workflow objects.

Business Actions for the Workflow On Entry Tab
As described in theViews and Mappings for Workflows section of theWorkflows documentation. Deadlines
can be viewed andmanipulated in views via the 'WorkflowDeadline' Component. In the public API, methods for
getting and setting deadlines are available via the Task interface. Below is an example of how a deadline can be
set to an hour from now in a business action, in anOn Entry tab.

var date = new Date();

date.setTime(date.getTime() + 3600000);

node.getTaskByID("Workflow ID", "State ID").setDeadline(date);

As the deadline is set via the Task interface, above will only work from the state with ID "State ID". An example can
be seen in the image below:

© Stibo Systems - Confidential - STEP Trailblazer 8.1 137



When viewed in STEPWorkflow, if a deadline is not yet met it looks like the image below:
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If a user wishes to remove a deadline from a business rule, this can be done by setting the deadline to null, as
shown below.

node.getTaskByID("Workflow ID", "State ID").setDeadline(null);

Editing Deadlines through Workflow's Views and Mappings
Deadlines can also be set by editing the workbench views andmapping for a given workflow. To do so:

1. Open the desired workflowsDesigner and go to Edit > Edit Workflow Views and Mappings.
2. In the view that needs a deadline added to it, right click on the view and selectAdd Column.
3. In the Component drop down, selectWorkflowDeadline.

Once selected, the deadline can be set manually in the object itself via the object's Task tab, or in the STEP
Workflows navigator tab.
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Note: State Editor Deadline/Escalation tab allows a user to set the deadline for all the products in a particular
state within the workflow, but the deadline set using workbench views andmappingswill apply for a particular
product in a particular state in a workflow.
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Deleting Objects in Workflow
It is sometimes necessary to delete a product that is in a workflow. This could be for many reasons, including that
the product is no longer needed or is discontinued. However, if the product is currently in a workflow and a user is
trying to delete an object in a workflow, the user will be prohibited from doing so unless they 'force delete' the
object.

The abovemessage will include the list of workflows in which the product exists. If the user chooses to force a
deletion, it will not only delete the product from the hierarchy but will also take it out from all workflows it is currently
in.

Note: For objects that are not deleted directly, but put into the Recycle Bin, theywill not be inserted into the states
theywere in prior to the deletion if revived.

A force deletion of a product that is currently in a workflow should only be done when a user is sure that the
product is no longer required.

Should a user move a product to the Recycling Bin, this will also take the product out of anyworkflows. However, if
the product needs to be revived from the recycle bin it should be known that once revived, it will not automatically
go back into anyworkflows and their states that it was in initially. If it is desired that the product that was revived
from the Recycling Bin go back into anyworkflows it once was in, then the option 'Initiate automatically' in System
Setup on the STEPWorkflow Editor tab needs to be checked for all the workflows that need that particular product
again.
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If auto-initiation is turned on for the workflow, a new instance will be created. Thismeans that if a product has an
object type which is valid for a particular workflow, then the product is automatically initiated to that workflow at the
beginning.
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Edit a Workflow in Use
Once a workflow has been created and is in use, it may be necessary to change it. If the workflow is not yet in use
(e.g. there are no active tasks for the workflow, or the workflow is in a test state only and not yet released for
production), editing a workflow is does not require any special considerations.

General information on creating and editing workflows can be found in theGetting Started with STEP
Workflows documentation, specifically in theCreating a Workflow andSTEP Workflow Designer topics.

This topic provides guidance specifically on editing workflows that are already in production and/or contain active
tasks.

Important considerations before editing a workflow in use:
l When there are objects in a workflow, certain changes to the workflow are prohibited as they could cause
disruption to the taskswithin them. Thus it is not possible to rename, delete, or change the state characteristics
of any states that have taskswithin them. In addition, states with active tasks cannot bemoved inside or taken
out of a cluster or parallel, and parallelsmay not have new clusters added.

l It is best to receive advice and guidance from a STEP expert beforemaking changes to a live workflow.

l It is always recommended to duplicate the existing workflow, do the necessarymodifications in the duplication,
test it, and then apply the same changes to the workflow in use.

l If the required changes are significant, it may be best to process all existing tasks in the workflow, andmake
sure that no new tasks are added, before the changes aremade to the workflow.

l Already existing business rules should be taken into consideration when editing a workflow. It is possible for a
rule to rely on a state that is deleted, event that is changed, etc that could prevent the rule fromworking
following updates to the workflow. It is important to evaluate all existing business rules following changes to a
workflow, and to test those that may have been impacted.
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Exporting Workflow Definitions
In order to move workflow configurations between systems and/or to compare workflow definitions using external
source control systems, workflow definitions can be exported using STEPXML and Advanced STEPXML.
Depending on the intended use of the output file, the appropriatemethod should be selected.

Exporting Workflow Configurations for Loading to Another System
Workflow definitions (including global and local business rules used by the workflow) can be exported in several
ways. The simplest of these is described here. Exports carried out in thismanner provide an encoded workflow
definition that, while not necessarily human-readable, provides all necessary information to replicate the workflow
on another STEP system.

A workflow definition (including used global and local business rules) can be exported in XML.

1. Right-click on the workflow object in SystemSetup and selectingExport STEP Workflow from themenu.

2. In the pre-configured Export Manager wizard, select 'STEPXML' on theSelect Format step.
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3. Next, make sure Include STEP Workflows file is set to 'All,' where 'All' means 'all selected workflows' i.e. the
workflow the user right-clicked to start with.

4. Lastly, make sure the Include Global Business Rules option is set to 'Referenced'. Thismeans that all
global business rules used in the workflow will be included in the export. Once done, navigate through the
wizard and click on Finish.

Note: Local business rules are exported nested in the STEPWorkflow element and will always be included.

The exported STEPXML file can be imported on another STEP system via the standard Import Manager.

The same export can also be accomplished using Advanced STEPXML. Following the steps outlined above, but
selecting the 'Advanced STEPXML format' on theSelect Format step of the Export Manager will yield a pre-
populated export template that will produce the same results.

Note: The export option on the workflow designer File menu lets you export the SCXML onwhich the workflow is
based. This option is for debugging only and should not be used to transfer workflow configurations between
systems.

Steps to export the workflow in the format of SCXML are below:
1. Go to SystemSetup and locate the workflow

2. Right click on the workflow and then click on Edit StepWorkflow option

3. In the new window, click on File -> Export, and then select the path in which the file is to be saved
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Exporting Workflow Definitions as Comments for External
Comparison
Workflow definitions can be exported as comments using Advanced STEPXML. These exports can be submitted
to external source control systems for comparison purposes. Exports generated in thismanner are not encoded
(as described above), allowing for readability by other systems. However, these exports do not provide the
necessary information to transfer a workflow between STEP systems and use in thismanner is not supported.

To export a workflow for external comparison, Advanced STEPXMLmust be used and the
DefinitionsAsComments tagmust be set to 'true'.

On the Select Format step of the outbound tool, choose the Advanced STEPXML format, then copy and paste the
following text into the Template field:

<?xml version='1.0'?>

<STEP-ProductInformation DefinitionsAsComments="true">

<STEPWorkflow ExportSize="All"/>

</STEP-ProductInformation>

An example of the output for a workflow definition as comments is shown below:

<STEPWorkflow...>
<!--Definition:[Workflow definition goes here. Removed for brevity.]-->
[Remaining configuration would populate here]
</StepWorkflow>

Note: The content of the comment field is not part of the STEPXMLXSD and therefore Stibo Systems reserves
the right to change the format of the output content at any time.

For more information, see theSTEP-ProductInformation Tag in STEPXML section of theData Exchange
documentation.
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Exporting Workflow Statuses
When exporting Products, Classifications, Assets and Entities it is possible to have workflow related information
included in the exported file.

When exporting STEPXML, option to include the information is found on the Select Format page ("Include STEP
Workflow Task Info" - yes/no). If set to "yes", then each object in the exported STEPXMLwill have a CurrentTasks
element with info similar to what is shown below.

<CurrentTasks>

<Task STEPWorkflowID="Item Introduction" StateID="Technical_Specifications"
AssigneeID="Stibo Technical Writers" AssignedToGroup="true" EntryTime="2012-10-
18 11:31:39" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="A_Parallel" AssigneeID="Super
user" AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C1" AssigneeID="Super user"
AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C1-Final" AssigneeID="Super
user" AssignedToGroup="true" EntryTime="2012-11-06 12:48:50" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C2" AssigneeID="Super user"
AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C2-Initial" AssigneeID="Super
user" AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 4-5-6" StateID="Some_State" AssigneeID="Super
user" AssignedToGroup="true" EntryTime="2012-11-05 14:45:18" Priority="-1"/>

</CurrentTasks>
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The same information can be included in column based exports, but here datamust bemapped into columns for
each workflow of interest.

To specify which type of workflow related data goes into a column, click the flipper button for themapped data and
click the transform button for the value part. In the dialog that appears it is possible to select between info types
shown below.
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Note:Workflow status export (STEPXML or Excel) is a kind of meta data information to communicate with the
other systems. Example: In case of translation XML the workflow states will act as a flag tomatch the status in
other systems.

For more information about exporting in STEPXML seeAdvanced STEPXML Format in theExporting Data /
Export Manager documentation.

For more information about exporting data in Excel format, seeExcel Format section of theData
Exchangedocumentation.
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Java API for Workflows
Complete documentation for API functionality related to workflows can be found in the STEP API documentation
at [system]/sdk. This topic provides some introductory information and simple examples, but should not be
considered comprehensive.

In the Public Java API "WorkflowableNode" is themain interface for Workflow related functionality. All the
"workflowable" node types inherit the interface and thus you can call the availablemethods from the node
shorthand.

If, for instance, you wanted to get the time where an object entered a specific state, on entry to the state you could
have a business action with a script like the one below, storing the entry time in the script variable "entryTime".

var entryTime = node.getTaskByID("Workflow ID", "State ID").getEntryTime();

Here the getTaskByID() method from theWorkflowableNode interface is called on node. This returns a Task that
has the getEntryTime() method (see the Task interface).

Note that this script will only work if the object is actually in the workflow with the specified ID and in the state with
the specified ID.

From a business rule used in a workflow (e.g. a local rule within the workflow itself), you can typically be pretty sure
that the object is in fact in the workflow. However, if you run from a business rule used elsewhere in STEP and
wanted to checkwhether an object was in a given flow, you could write something like:

if(node.getWorkflowInstanceByID("Workflow ID")) {

// Object is in Workflow - do something

}

else {

// Object is not in Workflow - do something else

}

Thus, if the object is not in the workflow, themethod returns "null" - a "false" value in JavaScript.

While in the entry time example above you could be sure that you were in the workflow, likewise if you ran the
script on entry to the state referenced with "State ID", you could be sure that you were in that state. However, if
you are working with parallels, you could wish to do something with a task on a state that is not the same as the
one you are running the business rule from. In that case it wouldmake sense to start your script with a check for
whether your object is actually in that other state:

var task = node.getTaskByID("Workflow ID", "ID of another State");

if(task) {

var entryTime = task.getEntryTime();

}

else {

logger.warning("Object with ID '" + node.getID() + "' is not in expected
State");
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}

The two primary interfaces available through theWorkflowableNode interface are Task andWorkflowInstance.
Via the Task interface you havemethods available that relate to a given object-in-state-in-workflow relation.
WorkflowInstancemeanwhile gives you access to themethods relating to the object-in-workflow relation. In the
Workflow Variables topic of the AdvancedWorkflow topics documentation, the concept of workflow variables is
described. These variables live on the object-in-workflow relation and can thus bemanipulated via the
WorkflowInstance interface.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 151



Localizing Workflow State Names and Events
End users interact with STEP inmany languages. Though a workflow may be initially created in one language,
end usersmay use a different language and would therefore prefer to see workflow state names and events in a
different language. This is possible using the Localize State Names and Events options in the STEPWorkflow
Designer. With this functionality, workflow designers can create a single workflow that includes localized workflow
state names and events, thus eliminating the need tomaintain multiple workflows for localization purposes.

To localize workflow state names or events:

1. From the SystemSetup tab, select the relevant workflow, right-click, and selectEdit STEP Workflow.
2. From the Edit menu in the STEPWorkflow Designer, select Localize State Names and Events.

3. Enter the localized values for each state name and/or event.
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Note: The languages available for translation are determined by two things: Translated workbench instances and
the locales available in theWebUI. WebUI locales are determined by the portal messages files in the
PortalLocales folder. The PortalLocales folder can be found on the application server in the location specified by
the Portal.Localizer.Folder property in the sharedconfig.properties file.

Localized values entered in the workflow designer appear when users access a workflow in the relevant locale-
specificWebUI or in a translated instance of the STEP workbench.Within the workbench, this includes but is not
limited to: STEPWorkflow tab, object Status and State Log tabs, and dropdown search optionswhen using a
STEPWorkflow search criteria.

For example, a user logging in to the Spanish workbench or WebUI locale would see the corresponding localized
values entered in the workflow designer.

Note: Changing the Context selection in the workbench does not have any impact on the display of localized state
names or events.

Considerations and Limitations:
l The name of the workflow itself is not translatable via this feature as this is driven by context. If the context
being viewed employs a different language than the translated workbench instance or selectedWebUI
locale, this could result in an end user seeing the name of the workflow itself and the states and/or events
within the workflow in different languages.

l Offline translation of state names and events via export / import is not supported. Exports of workflowswith
localized state names or events include the localized values and import to new systemswill reflect the
localizations. If an imported workflow containsmore locales than the target system, only locales common to
both systems are displayed. If a new locale is later added on the target system and localized values exist for it
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via previous import, the localized valueswill display. If an imported workflow contains fewer locales than the
target system, translations on the target system that are existing will be deleted, since the imported workflow
definition will be seen as the governing workflow.
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Mandatory Attributes in Workflows
It is often necessary that certain attributes or attribute groups be set asmandatory for a state or transition in a
STEPWorkflow. Thismeans that the object can pass further in the workflow only if the indicated attributes have
values. To facilitate this, the relevant mandatory attribute groups and/or attributes can be indicated directly in the
STEPWorkflow Designer, enablingmandatory attributes to be applied once and take effect across all interfaces
(workbench,WebUI, and Smartsheets), without requiring any additional configuration. In addition, attributes and
groups can be set to be conditionallymandatory, meaning they are only required if specific conditions aremet.

This topic describes the functionality for making attributesmandatory specifically within a workflow state or for a
particular workflow transition. In using this functionality, it may also be helpful to understand the other mandatory
attribute settings (e.g. those that are not specific to objects within a workflow).

For more information on general mandatory attribute settings, see theMandatory Attributes topic in the
Attributes section of theSystem Setup / Super User Guide.

Setting up Workflow State Mandatory Attributes
Users can specify which attributes and attribute groups aremandatory via the State Editor. Mandatory attributes
configured on a state will bemarked with an asterisk when working inWebUI.

1. InSystem Setup, locate and select the desired workflow.
2. Right-click and selectEdit STEP Workflow.
3. In the STEPWorkflow Designer, select the state in question, right-click and selectEdit State to edit the state.
4. Locate theMandatory Attributes tab in theState Editor.
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5. ClickAdd Attribute Group orAdd Attribute to add an attribute / attribute group to the list of mandatory
attributes.

6. If themandatory status of an attribute needs to be determined by a business condition, click the ellipses button
next to the applicable attribute. In theMandatory Condition editor, configure an appropriate business condition
or select a global business rule.

Note that unless the condition returns 'False' the attribute will remainmandatory.

For more information about conditionallymandatory attributes, see theConditionally Mandatory Workflow
Attributes section of theSTEP Workflows documentation.

7. Save the workflow.

If anymandatory attributes aremissing when submitting an object in STEPWorkbench or WebUI, an error
message listing all missingmandatory attributeswill appear, preventing the user from progressing through the
workflow. For more information on howWebUI handles this, see theWorkflow Mandatory Attributes in Web
UI section of theWeb UI Getting Started documentation.

In the Excel Smartsheets, users will receive the necessary information when working with objects that have state
mandatory attribute(s) and/or attribute group(s). For more information see theAdditional Information About
Smartsheets section of theSmartsheets documentation.

Setting up Workflow Transition Mandatory Attributes
Users can specify which attributes and attribute groups aremandatory via the Transition Editor.

1. InSystem Setup, locate and select the desired workflow.
2. Right-click and selectEdit STEP Workflow.
3. In the STEPWorkflow Designer, select the transition in question, right-click and selectEdit Transition to edit

the transition.

4. Locate theMandatory Attributes tab in the Transition Editor.
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5. ClickAdd Attribute Group orAdd Attribute to add an attribute / attribute group to the list of mandatory
attributes.

6. If themandatory status of an attribute needs to be determined by a business condition, click the ellipses button
next to the applicable attribute. In theMandatory Condition editor, configure an appropriate business condition
or select a global business rule.

Note that unless the condition returns 'False' the attribute will remainmandatory.

For more information about conditionallymandatory attributes, see theConditionally Mandatory Workflow
Attributes section of theSTEP Workflows documentation.

7. Save the workflow.

If anymandatory attributes aremissing when submitting an object in STEPWorkbench or WebUI, an error
message listing all missingmandatory attributeswill appear, preventing the user from progressing through the
workflow. For more information on howWebUI handles this, see theWorkflow Mandatory Attributes in Web
UI section of theWorkflows in Web UI documentation.

Smartsheets State Mandatory Attributes
It is possible to enforce themandatory status of an attribute or attribute group via business conditions set on a state
or transition in a workflow.Whenmaintaining objects in a Smartsheet that has been exported for a workflow state
(i.e. from theWebUI Tasklist), any cells containing attributes that are conditionallymandatory for that particular
state are highlighted blue. Additionally, unless the condition driving themandatory status of the attributes returns
'False', the user must enter values for all applicable attributes before the sheet can be validated.

Note: Transitionmandatory attributes and attribute groups are not supported in Excel Smartsheets.
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For more information about conditionallymandatory attributes, see theConditionally Mandatory Workflow
Attributes section of theSTEP Workflows documentation.

Set Workflow to Ignore Mandatory Attributes
After settingmandatory attributes on a state, transition, or on aWebUI screen, specific events can be identified for
which the population of the attributes should not be enforced. This allows an object to move through designated
states in a workflow, even when the object ismissingmandatory attribute values.

In the below example,Color andMaterial are set asmandatory attributes on theReview Data state. If the user
does not populate these values on a given product and attempts to submit from the state via any transition (Reject
or Approve), the object would not be able to proceed through the workflow until themissing valueswere
provided. However, if theReject event is set to ignoremandatory attributes, the user may return to the previous
state in the workflow even ifColor andMaterial havemissing values.

1. In the workflow editor, navigate toEdit.
2. ClickEdit Event Mandatory Settings.

3. In the pop-up window, check the appropriate event(s) for whichmandatory attribute requirements should be
ignored, and then close the window.
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4. Save the workflow.

Note:While this can also be accomplished by settingmandatory attributes on transitions themselves, theWebUI
only provides a visual indicator (asterisk) onmandatory attributes that are set in workflow states. This feature
allows users to see the visual indicator for mandatory attributes required for forward progression, while also being
able to disregard these requirements for certain transitions, such asRejections.

Note: Mandatory attributes set on aWebUI screen are only honored if the 'Submit Action' has 'Enforced Validity'
checked.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 159



Conditionally Mandatory Attributes in Workflows
Sometimes it is essential for an attribute to be populated in one or two specific cases, but is otherwise
unnecessary. To account for these cases, themandatory status of attributes on objectsmoving through a
workflow can be enforced via business conditions set on a state or transition.

Mandatory attributes configured with a condition will remainmandatory unless that condition returns false,
indicating that the condition was not met and the attributes in question are not required when proceeding to the
next state in the workflow. Like standardmandatory attributes, if conditionallymandatory attributes aremissing
valueswhen attempting to submit an object to the next state, the object is prevented from progressing through the
workflow and the user receives amessage listing the attributes that havemissingmandatory values. InWebUI ,
these conditions can be evaluated on the fly and dynamically reflected as the user workswith the data, with a
change inmandatory status being reflected on the screen in real time, allowing users to react immediately, without
having to submit and receive an error message.

For more information about settingmandatory attributes in workflows, see theMandatory Attributes in
Workflows section of theWorkflows documentation.

Configuring Workflow States / Transitions with Conditionally
Mandatory Attributes
A condition can bemapped to an attribute or a group of attributes on either a state or transition in a workflow.

1. Navigate to theMandatory Attributes tab in the State / Transition Editor.
2. Locate the relevant attribute(s) and click the ellipses under the 'Condition' column.
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3. In the editor that appears, specify the condition to use by selecting a global business rule via the 'Business
Rule' ellipses. Once the selection ismade, close the editor.

Alternatively, you can create a new business condition by clicking the 'Add new BusinessCondition' link at the
bottom of the editor, and then click theEdit Operation button that appears. From the dropdown, select
'Evaluate Javascript' and enter the business condition in the Javascript area.

Important: For use with conditionallymandatory attributes, the business condition should only return 'True' or
'False'. If anything else is returned it will be treated as 'True'.

Once finished, clickSave and close the editor.
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For more information about BusinessRules, see theBusiness Rules section of theBusiness Rules
documentation.

4. Close the State / Transition Editor and Save the workflow.

Conditionally Mandatory Attribute Handling in Web UI
InWebUI, themandatory status of attributes can be evaluated on the fly as the user workswith the data, with any
change inmandatory status being reflected on the screen in real time. In order to display these dynamic changes,
the attribute values driving the conditionmust be bound to that condition in the business rule configuration.While
the condition driving themandatory status of an attribute can takemore than just attributes into account, if
something else is driving the condition, such as a reference, the page will need to be refreshed in order update the
interface.

Important: Note that the use of business rules to determinemandatory status of an attribute should be done with
care as the performance of the dynamic behavior of the editors could be impacted if highly complex business rules
are used.

When viewing a state in a Node Editor, any attributes that are currentlymandatory aremarked with an asterisk. If
the condition returns false due to changes in data on the page, these indicators vanish. Additionally, if there are
anymissing attributes that are currentlymandatory, the Submit / Approve button will be locked.

Note: Conditionallymandatory attributes on transitions do not have visual indicators to end users as they are not
evaluated until the transition is selected. That said, the warningmessage will still appear listing themissing
attribute values.

OnNode Lists usingMulti-Edit DisplayMode, conditionallymandatory attributes are indicated by highlighting the
cell blue. Aswith the Node Editor screen, themandatory status is dynamically evaluated so if the condition returns
false, the highlighting disappears.

Example
The business condition states that if the value of the attribute 'Multiplayer' is 'Yes', the attributes 'Co-op' and 'PvP'
aremandatory. Otherwise, 'Co-op' and 'PvP' are not mandatory.

In the image below, the condition is returning true for the Space Adventure Game, so 'Co-op' and 'PvP' are
mandatory (and are highlighted blue). Clicking Submit / Approve if either mandatory value ismissing will result in
an error message listing whichmandatory attribute(s) aremissing. If both attributes have values they are free to
move on to the next state.
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In the image below, the condition is returning false for the Space Adventure Game, so 'Co-op' and 'PvP' are not
mandatory (and are not highlighted). This object is free tomove on to the next state, even if 'Co-op' and 'PvP' don't
have values.

In the image below, the condition is returning true, so 'Co-op' and 'PvP' aremandatory (and aremarked with
asterisks). Since they have values, the Submit / Approve button is enabled.

In the image below, the condition is returning false, so 'Co-op' and 'PvP' are not mandatory (and are not marked
with asterisks). Since it does not matter if they have values, the Submit / Approve button is enabled.
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In the image below, the condition is returning true, so 'Co-op' and 'PvP' aremandatory (and aremarked with
asterisks). Since 'Co-op' ismissing a value, the Submit / Approve button is disabled.

Conditionally Mandatory Attribute Handling in Smartsheets
Smartsheets can also indicate themandatory status of attributes based on conditions. If exported on the relevant
state of the workflow, any attribute values that are currentlymandatory are highlighted blue. If changes aremade
to the attribute values driving the condition, the sheet needs to be validated to reflect those changes.
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Example
The business condition states that if the value of the attribute 'Multiplayer' is 'Yes', the attributes 'Co-op' and 'PvP'
aremandatory. Otherwise, 'Co-op' and 'PvP' are not mandatory.

In the image below, the condition is returning true, so 'Co-op' and 'PvP' aremandatory (and are highlighted blue).
The sheet can be validated without errors.

In the image below, the condition is returning false, so 'Co-op' and 'PvP' are not mandatory (and are not
highlighted). The sheet can be validated without errors.

In the image below, a validation was run and reported the object and itsmissing attributes by highlighting their cells
red. The sheet failed because condition was true and 'PvP' wasmissing a value.

Conditionally Mandatory Attribute Handling in Workbench
Support for conditionallymandatory attributes is also available in the workbench, though visual indicators are not
managed in relation to this. When attempting to submit an object, conditionallymandatory attributes are evaluated
and an error is presented to the user listing anymissing conditionallymandatory attributes (in the samemanner as
standardmandatory attributes are reported).

Determining Mandatory Status of an Attribute
Any attributes / attribute groups specified under the 'Mandatory Attributes' tab of a workflow state are considered
mandatory if:

l There is no condition set for the attribute / attribute group

l The condition is not applicable for the object type of the object being evaluated

l There is a pre-condition on the rule that is not met and therefore the condition is not evaluated
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l The condition fails

l The condition returns 'True'

The only case in which an attribute / attribute group is not consideredmandatory is if the condition returns 'False'.

Because themandatory status of an individual attribute can be determined in a number of different ways, some
methodsmust take priority over others:

l An individual attribute specified on the state / transition takes priority over attributes specified as part of a
group.

l If an attribute is listed viamultiple groups, the group configured with a condition takes priority.

l If an attribute is listed viamultiple groups andmore than one of those groups is configured with a condition,
only the first condition listed is applied.

l If the attribute is explicitly defined asmandatory inWebUI via being set asmandatory on the screen, that
setting overrides any conditions that may say otherwise.
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Monitoring Workflows
Workflows can bemonitored viaWorkflow Profiles. Profiles aremaintained on the Profile sub-tab of the STEP
Workflow navigator tab. Profiles are available to users with the 'View andMaintain STEPWorkflow Profile'
privilege. A Profile can contain a wealth of information about workflows, such as: number of exceeded deadlines,
how long the tasks have been assigned to the assignees, what is the workflow throughput thismonth versus the
last sixmonths, etc. This is all configured using the STEPWorkflow ProfileWizard.

To create a new Profile, navigate to SystemSetup, and click theCreate new link at the bottom of the Profile sub-
tab.

Step 1: Label and Type
In the wizard that appears, provide an ID, Label (name), assign a SetupGroup, and choose a Domain.
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TheDomain options are the following:

Domain Description Example

States Allows a user to view data
focused on workflow states.

l How many objects are in the various states of a workflow

l Who the state tasks are assigned to

l How long the objects have been in the states

l Number of exceeded deadlines

l How long the objects have been in the states that are
assigned to a particular user or group

l How many objects have passed through the states today
versus yesterday, versus the day before, etc.

Assignee Allows a user to view data
focused on assignees.

l How many tasks are assigned to the various assignees

l How long the tasks have been assigned to the assignees

l If the assignees have taskswith exceeded deadlines

l How many tasks the assignee has completed this week
versus the week before, etc.

STEP
Workflows

Allows a user to view data
focused on entire workflows.

l How many objects are currently in the workflows

l How long the objects have been in the workflow, on
average

l What is the workflow throughput thismonth versus the last
sixmonths, etc.
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Step 2: STEP Workflow Filtering
Next, fill out the STEPWorkflow Filtering screen. The workflows or workflow states (within one or multiple
workflows) that the profile should contain will be specified here. The options differ somewhat for each domain
(selected in the previous step). Since profiles are not limited to a single workflow, a user could have an Assignee-
domain Profile that shows information for tasks in numerousworkflows.

According to the domain chosen, the following options are available:

l States domain: Here a user will specify whether the profile should contain data from allworkflow states or if it
should be limited to specific workflow states only. Note that if 'All States with tasks' is selected, the profile will
contain data from every workflow state, from every workflow in the system. The option to 'Hide States with no
Tasks' is unavailable if this option is selected.

l Assignees domain: The STEPWorkflow Filtering wizard screen for the Assignees domain contains the
same options as the screen that appears for the States domain.

l STEP Workflows domain: Only entire workflows can be chosen for this option. Data cannot be filtered down
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to the task level.

STEP 3: Collection Filtering
For Collection Filtering, a user can filter the profile results to contain information only for objects in a given
collection. This step is optional.

For example, a user could create a profile that only shows data for objects that are to go live at a certain date, or
only shows data for objects in a particular part of the tree hierarchy.
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Step 4: User / Group Filtering
Here a user can filter the profile results to contain information only for tasks that are assigned to specific users or
user groups.

Note: Step 4 is disabled for the STEPWorkflows domain.

For example, in theAssignee domain, the 'Specific Users / Groups' option is valuable if a user would like to view
the workload for a number of users. If the 'Assignees' option is selected, users with no taskswill also be included in
the profile.
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Step 5: Display
The profile display will be different depending on which domain was selected in Step 1. For theStates and
Assignees domains, the profile will consist of two tables: aMaster Table and aDetails Table.

Table Description

Master
Table

Displaysmore general information about the states or assignees.

Details
Table

Appears when a row in theMaster Table is selected—displaysmore specific information about the
objects that are contained within a state or assigned to an assignee.

For theSTEP Workflows domain, there is only a singleMaster Table. Step 5 is where a user specifies which
columns should be shown in these tables.

Common to all domains are the two divisions of theMaster Table settings: Live Data andOn Demand Data.
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Table Settings Description

Live Data Data that can be kept up to date automatically—data for workflow instances in their present
state.

On Demand
Data

Historical data that is retrieved from the object's State Logs.

As the name indicates, this data is only generated on demand. For all three domains, the OnDemand section
allows a user to specify a time period of days, weeks, or months for which theywould like to generate historical
data. For example, if you select three (3) days, the generatedOnDemand table will display three columns, one for
each selected day (e.g. "Throughput today," "Throughput yesterday," "Throughput 2 days ago.")

The following sections explain the different options by domain, for Step 5:
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States Domain

Table
Settings

Description

Master
Table-
Live Data

l Show count column: Number of objects currently in the state

l Show average time in State column: Average time that the objects have been in the state

l Show STEPWorkflow column: Name of the workflow to which the state belongs

l Show exceeded Deadlines column: Number of exceeded deadlines for objects in the state,
followed by the average exceed time

l Show maximum time in State column: The longest period an object currently in the state has
been there

Master
Table-On
Demand
Data

l Show historical throughput: Number of objects that have exited the state within the given
period (day/week/month). The number is increased each time an object exits the state,
regardless of whether the object has been in and exited the state earlier.

l Show historical average time in state: Average time that objects—which have exited the state
within the given period (day / week / month)—were in the state

Details
Table

l Show STEPWorkflow column: Title of the workflow to which the state selected in theMaster
Table belongs

l Show time in State column: How long the object has been in the state

l Show Assignment time column: How long the task (which the object-in-state represents) has
been assigned to the current assignee

l Show Deadline column: The deadline, if any

l Show Assignee column: The assignee

l Show Status Flag column: The current status

Assignees Domain

Table
Settings

Description

Master Table-
Live Data

l Show count column: Number of tasks currently assigned to the User/Group

l Show average Assignment column: Average time the current tasks have been assigned to
the user / group

l Show exceeded Deadlines column: Number of exceeded Deadlines for Tasks assigned to
the user / group, followed by average exceed time

© Stibo Systems - Confidential - STEP Trailblazer 8.1 174



Table
Settings

Description

l Show maximumAssignment time column: Longest period that a task has been assigned to
the user / group

Master Table-
OnDemand
Data

l Show historical number of assignments: Number of assignments within the given period
(day / week / month). i.e. how many times during the period have tasks been assigned to
the user / group

l Show historical number of completed tasks: Number of tasks that were completed within
the given period (day / week / month) while assigned to the user / group

l Show historical avgerage assignment time: Average time taskswere assigned to the user /
group within the given period (day / week / month)

l Show historical average completion time: Average time within the given period (day / week
/ month) that it took a user / group to complete a task, once assigned

Details Table l Show STEPWorkflow column: Name of the workflow in which the task exists

l Show State column: The state in which the task exists

l Show Assignment time column: How long the task has been assigned to the current
assignee

l Show Deadline column: The deadline, if any

l Show time in State column: How long the task has existed, i.e. how long the object has
been in the state

l Show Status Flag column: The current status

STEP Workflows Domain

Table
Settings

Description

Master Table-
Live Data

l Show count column: Number of objects currently in the workflow that are not in a final state
on the outer level

l Show average time in STEPWorkflow column: Average time the objects have been in the
workflow

Master Table-
OnDemand
Data

l Show historical throughput: Number of objects that have reached a final state on the outer
level during the given period (day / week / month)

l Show historical avg. time in STEPWorkflow: Average time that it took objects to reach a
final state on the outer level (from time of workflow initiation) during the given period (day /
week / month)

© Stibo Systems - Confidential - STEP Trailblazer 8.1 175



Profile Editor
Once a profile has been configured, it is possible to generate the OnDemand data by clicking the 'Update on-
demand data' button at the top of the Profile tab. From here it is also possible to edit the configuration and copy the
master table data into the clipboard, allowing you to easily paste it into a spreadsheet (e.g. Excel).

It is important to note that the 'Update on-demand data' button option will be available only if either one or both of
the check box options under OnDemandData is checked. These options are 'Show historical throughput' or
'Show historical avg. time in state' while creating a new profile. If the option is not available, it can be enabled by
editing the configuration.

Once the 'Update on-demand data' option is run, a background process is created, and then the table is updated.
Themain use of this option is that it will display the number of objects that have exited the workflow (for STEP
Workflow domain) within the given period or based on the average time in state.

Note: Data fromWorkflow Profiles can be represented in widgets on theGlobal STEP Dashboard. For more
information, please see theGlobal Dashboard topic in theData Quality documentation.
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Remove Objects from Workflows
There aremany reasonswhy an object may need to be removed from aworkflow. A few of the reasons for
removing an object from aworkflow are:

1. It has finished going through the workflow

2. The object needs to be amended before being put back into the workflow

3. The object is no longer relevant for the workflow

Nomatter the reason for removing an object from aworkflow, objects can be removed, i.e., taken out of
workflows, in several different ways.

Remove Single Object
If a user wants to remove a single object from aworkflow, and they have the 'Remove Items fromSTEPWorkflow'
privilege, this can be accomplished via theRemove from STEP Workflow context menu option on the object.

To do so, right-click on an object, or product, and selectRemove from STEP Workflow.
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Remove All Objects from a Workflow
If a user needs to remove all objects from aworkflow, and they have the 'Remove Items fromSTEPWorkflow'
privilege, this is possible via the workflow context menu optionRemove items from STEP Workflow.

Navigate to SystemSetup, right-click on the workflow that needs all items removed, and selectRemove items
from STEP Workflow.
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Remove Objects from a State Using Bulk Updates
Should a user want to remove all objects from one state in a workflow, they can do so using Bulk Updates if they
have the ability to search the STEPWorkflow tab, and they have the 'PerformBulk Update' privilege.

1. First navigate to themain Search tab, and once on the tab, from the dropdown Searchmenu selectSTEP
Workflow.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 179



2. Next, from the two drop downmenu, selects the desired workflow and then specifies which state all objects are
to be removed from. PressSearchwhen finished.

3. Once the search result displays, click on the Bulk Updates button at the bottom of the results list.
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4. The Bulk Updateswindow will display. Click next and on the second step,Operations, from the drop down
menu at the top select Workflow > Remove items from STEP Workflow.

5. Select the desired workflow, enter a 'ProcessNote' if desired, and select Finish. This will remove all objects
from the state.
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Removing Objects from the Final State
As objects per default stay in the workflow's final states until explicitly removed, it is highly recommended to
automatically take the objects out of the workflow when reaching a final state on the outer level. If below script is
entered in a business action configured 'On Entry' to the final state, once objects enter the state, theywill be
removed from the workflow and the supplied process note posted to the State Log if one was entered.

node.getWorkflowInstance(workflow).delete("Object automatically removed from
Workflow");

1. To add the above script to a business action, navigate to SystemSetup, open the desired workflow's STEP
Workflow Designer, and right-click on the outer level Final State.

2. In the dialogue that appears, select the On Entry tab > Add new Business Action >Merge into.
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3. Select 'Execute JavaScript' from the dropdownmenu, and click on theEdit Binds button, to add any
necessary binds. Note that the two binds being added for this particular workflow are:Workflow to Current
Workflow and Node to Current Object.
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4. Next add the following script in the JavaScript window. Notice how the variable name for the CurrentWorkflow
Bind is used. Users shouldmake sure to replace with their variable name in the script.
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Running Background Processes from Workflows
Via the API Task interface, it is possible to start a background process, BGP, and have events triggered on the
taskmatching the end status of the background process. Image below shows a simple workflow where an
Approve Recursively Background Process is started when entering the 'Trigger_BGP' state. When the
background process is done, one of the transitions out of the state will be performed based on the end status of the
background process. I.e. If the end status is 'succeeded', the "bgp.succeeded" event will be triggered. If it is failed,
the "bgp.failed" event will be triggered. Similar to the "StateID.Something" (where 'Something' stands for the
user's word choice) and "stibo.import" events, any event beginning with "bgp." will be hidden in the STEP
Workflow Items editor and on theObject Tasks tab.

In the picture below, as soon as a task is released to the 'Trigger_BGP' state, the Approve Recursively with a BGP
process script will execute.

Once a BGP has finished, if a particular task / item needs to be investigated, a user can navigate to its State Log
tab and see all Background Process ID's that occurred.
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Should the user need to examine any background process information further, they can do so by either going to
themain BGProcesses tab and looking at the receptive workflow's background processes or by searching for the
Background Process ID.

If the BGP should fail, looking at the BGP report can help in determining why.
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In the case of this 'Approve Recursively' workflow example, the taskwill bemoved to the Failure state, and only
once the error is fixed, then the task can bemoved from the Failure state by selecting the event 'Try_Again'. Then
if the BGP is successful, it will move to the Success state.

On Entry Background Process Script
While the script below could be used for other scenarios, two scenarios that this script can be used with workflow
for are the following:

1. If an object is required to run a translation, and it ismandatory that an object is in the approved state before
running the translation.

2. If there is any extraction required from the Approved workspace

TheOn Entry script that starts the background process is shown below. The last line stores the ID of the started
background process in a workflow variable with ID "BGP ID". The ApproveRecursiveServiceDescriptor is
described in the public API documentation.

var task = node.getTaskByID("WokflowID", "WorkflowStateID");
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var serviceDescriptor =
com.stibo.services.base.approverecursive.ApproveRecursiveServiceDescriptor;

var parameter = new serviceDescriptor.Parameter();

parameter.context = step.getCurrentContext();

parameter.nodes = [node];

var bgp = task.startBackgroundProcess(serviceDescriptor, parameter, "Started
from Workflow");

node.getWorkflowInstance(workflow).setSimpleVariable("WorkflowVariableID",
bgp.getID());

Note: The "WorkflowID" and "WorkflowStateID" in the top line, and "WorkflowVariableID" in the bottom should
be replaced by the users desired workflow information.

TheOn Entry script in the state "Trigger_BGP" will look like the image below. Also notice that the image below has
filled in the appropriate "WorkflowID," "WorkflowStateID," and "WorkflowVariableID" in accordance to the
workflow information.
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Send Email from a Workflow
Generally emails are sent from aworkflow to a user to escalate the importance of a task as it moves during the
transition from one state to another. There are a number of reasonswhy a workflow might be setup to do this. One
reasonmight be that a taskwas rejected from a state by the 'reviewer' due to the task not being done correctly. In
this case, if there was a business action set up on the transition to notify the previous user, the user then would
receive an email saying that the task they had previously pushed through was sent back. Nomatter the reason for
setting up email notifications fromworkflows, it is possible to set this configuration up via a business action utilizing
the "mailer" script shorthand. The business action can be configured or used on the State Editor screen in the
'Deadline/Escalation', 'On Entry', or 'On Exit' tabs, as well as on the Transition Editor on the 'On Transition' tab.

Dynamic Email Addresses
When sending emails from aworkflow, it is often necessary to send emails to different users who interact with the
sameworkflow. One scenario for thismight be that a number of usersmay claim tasks from the same state. If the
task is later released, and then rejected due to an error, it is important to inform the correct user who last worked
on it.

Configuring Emails from Workflows
The script example below shows how an email address defined on a STEP User can be obtained, and how an
email without attachments is sent to that user. In the following example, this script is used on a Transition Editor on
the 'On Transition' tab.

var userId = node.getWorkflowInstance(workflow).getSimpleVariable
("VariableHoldingUserID");

var emailAddress = step.getUserHome().getUserById(userId).getEMail();

if(emailAddress) {

mailer.send("noreply@stibo.com", emailAddress, "From Workflow",

"This is a mail sent from a Workflow");

}

else {

logger.warning("No email address specified for User with ID " + userId);

}

Conditions
To execute the above configuration, the following two conditionsmust bemet for 'Sending Email from aWorkflow'.

1. A SimpleMail Transfer Protocol (SMTP) server must be configured in the executing system.
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2. The user who is to receive the email should be entered into the User tab under description. To do so, go to
SystemSetup, navigate to the node that housesUsers andGroups, expand the node and click on the user who
will be emailed. Enter in their name and email.

In the example below, there are two business actions set up to send emails to various users.
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One business rule is on the State Editor on the 'On Exit' tab coming from the Edit state going to the Review state.
This business action, which is pictured below, is set up to retrieve the email ID of a user who submits a task from
Edit state to the Review state as a variable. In this case, 'Released_by' is the variable defined to retrieve the email
ID.

SeeWorkflow Variables in theWorkflows documentation for more on workflow variables.
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The second business action is on the Transition Editor on the 'On Transition' tab. This transition is coming from the
Review state going to the Edit state and has the event nameReject.

Here the business action script uses the variable 'Released_by' as well, where it is helping to identify who to send
the workflow email to and notify that the task they just submitted was rejected. This script also is sending the email
to the user without any attachments other than themessage. Notice that themessage shown in pink here, can be
crafted to say anything that might be helpful to the receiver whenever a task is rejected.
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It is important to note that if there is no email address registered, or if the email is not a valid one, the executing
user is not notified (e.g. no pop-up appears). However, it is captured in the STEP system log on the application
server.

If the user doing the rejecting should be notified that no email was sent and provided with an error message, then a
business conditionmust be added to the Transition Editor on the 'Condition' tab. The following script is what
should be entered in below.

var userId = node.getWorkflowInstance(workflow).getSimpleVariable("Released_by");

var emailAddress = step.getUserHome().getUserById(userId).getEMail();

if(emailAddress) {

return true;

}

else {

return "No email address specified for User with ID " + userId;

}
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Static Email Address
In the above scenario, STEP will trigger emails to the executing users. However, in some cases the same user will
always need to be notified and never change (a static email address). In this case it is possible to send emails to
the static email addresswith the 'Send Email' operation, and no JavaScript is needed.

This 'Send Email' operation can be added in a State Editor on the 'On Entry', 'On Exit' or 'Escalation' tabs. It can
also be sent in the Transition Editor on the 'On Transition' tab. Select the appropriate Editor and tab and then
select Add new Business Action > Merge into > Send Email.
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State Characteristics in Workflows
The State tab of the State Editor allows for workflow designers to assign specific characteristics to a state.

When creating states for a workflow, not all states need a characteristic assigned to them. Many states will not
have any characteristics assigned, but in some cases state characteristics become very important. For example, in
order for a workflow to be valid, it needs one Initial state and one Final state. Additionally, if clusters are present in
a workflow, there also needs to be one Initial state inside the cluster.

This section of the documentation describes the various state characteristics and how they are used within
workflows, specifically:

l Initial and Final

l Clusters

l Parallels
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Initial and Final States in a Workflow
A workflow can have asmany states as it needs in order to correctly depict the action or actions taking place.
These states all must have at least one transition coming into the state and at least one outgoing transition from the
state. However, the two states that every workflow need, the Initial State and a Final State, do not necessarily
have to abide by these transition rules depending on the workflow layer they reside in.

Initial
Initial State
The Initial State, represented by a slightly darker colored state, signals to an object entering the workflow where
to start. This could be in a simple workflow, such as the one pictured below, or it could be in regards to telling an
object which state to start with when entering a cluster. There can only be one outer Initial State for the general
workflow, and there can only be one Initial State inside each cluster. An outer layer Initial State does not have an
incoming transition, only an outgoing transition. This outer Initial State signals to the object / task entering the
workflow where to start. Once an object knowswhat state to start with, the workflow can progress.

For more on Clusters, seeClusters in Workflows in theWorkflows documentation.

Initial as a Parallel
It is often necessary for more than one incident to take place at a time in a workflow. In this case, aParallel
structure should be used as the Initial State, which auto-initiates the object into the Initial Stateswithin each
cluster simultaneously. The object only leaves theParallel once the object has reached the Final State in each
cluster.
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For more on Parallels, seeParallels in Workflows in theWorkflows documentation.

Final State
Stateswith the Final characteristic are used to denote the ending of either an entireWorkflow or a Cluster. Only
Final States within Parallels and Clusters can have an incoming and outgoing transition.
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All workflows should have a reachable outer layer Final State. Never-ending workflows can lead to performance
impacts. However, there cannot be transitions out of a outer layer Final State characteristic, only incoming
transitions. For this reason the outer layer Final State rarely represents a human task. When an object reaches a
Final State on the outer level of a workflow (not in a Parallel or Cluster), it will remain there until the object is taken
out of the workflow.

For performance reasons, and because the workflow cannot be started again on an object already in the
workflow, it oftenmakes sense to automatically remove objects from the workflow as they reach a Final State on
the outer level.

For more on how to automatically remove an object from aworkflow seeRemove Objects from Workflows in
theWorkflows documentation.
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Clusters in Workflows
A cluster is a grouping of states. There are twomain reasonswhy a grouping of particular statesmight be
beneficial within a workflow. It may be useful for purely administrative reasons, making it possible to easilymonitor
a section in a workflow, or it may be used in conjunction with other clusters inside of a parallel, which is themore
likely use case. For whatever the reasonmay be, it is important to know how to clusters work and how to create
them.

Creating and Entering Clusters in Workflow
Any state can have the cluster characteristic added to it. Thismeans that the particular state can have sub-states.
The first sub-state in a cluster has to be an Initial state in order for the workflow to be valid. Thismeans that there
could bemultiple states in a workflow with the characteristic of Initial state.

Note: For more on the Initial state, see Initial and Final States in a Workflow in theWorkflows
documentation.

It is important to note that states with cluster characteristics are still states in their own right. If an object is in a
cluster sub-state, it is also at the same time in the state with the cluster characteristic.
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If a state with a cluster characteristic contains sub-states, the cluster characteristic cannot be deselected in the
State Editor.

In looking at the following cluster, it is important to know how an object placed into the workflow wouldmove
through it.
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1. After entering into the 1st Initial State, an object enters into the 2nd State,which also happens to be a
cluster.

2. Once in the cluster, the object also simultaneously enters into the 3rd State-Initial.
3. It then proceeds through the next ordered steps until it reaches theEnd Inside Cluster (Final state).

Because this is inside of a cluster, there is a transition allowed out of thisFinal state (which is different than
what is allowed for the ultimate Final state of a workflow). In this case, it exits not only theEnd Inside Cluster
(Final state), but it also exits the entire cluster and goes to the 7th State.

4. From the 7th State, it proceeds to theEnd of Workflow (Final state). The object has reached the end of the
workflow.

Exiting a Cluster in a Workflow
When exiting a Final state in a cluster, the name of events on transitions can aid with the progression of the
workflow. If an event on a transition has the naming formula of 'cluster state ID.done' the transition out of the Final
state with the cluster characteristic to the next state will be triggered automatically.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 202



For example, in the picture below, the name of the event on the transition fromEnd Inside Cluster (which has the
characteristic of a Final state) to 7th State is being named. Following the formula to trigger the transition
automatically, the name takes on the 2nd State cluster's ID followed by '.done'.

This is useful for clusters that have their last state in the cluster with the characteristic as Final state, such as the
one in the example. Normal functionality dictates that an object in a Final state would stay there until it is manually
taken out or there is special coding set up to take the object out of the workflow automatically. However, with this
naming system there is no need for amanual removal or special configurations to progress the object through the
workflow. This naming configuration allows the object to leave the Final state within the cluster, and also leave the
cluster state itself.

The systemwill always look for a transition out of a cluster that has an event name of 'Cluster ID.done'. If there is
not a transition found with this name, the systemwill look for a transition out of the cluster with no named event and
perform that transition.

If there are two or more transitions out of the cluster that all have either the 'Cluster ID.done' event name or no
named events, the systemwill randomly perform one of the transitions unless conditions on the transitions
determine which one to perform.

If there are only transitionswith named events different from 'Cluster ID.done' out of the cluster, objects will remain
in the Final state and can only be progressed by triggering events on the cluster state.
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Note: Prefixing an event on a transition with the ID of the state fromwhich the transition goes and a dot ('.') will
cause the event to be hidden to users working with the workflow in the workbench. This approach should
therefore be used whenever you have a 'system' event that should not be triggerable by human users.

The image below shows an alternate way of configuring a cluster and transition relationship. Here there is no Final
state inside the cluster. Instead there is a transition directly fromEnd Inside Cluster to 7th State outside the cluster.

When this transition is performed, the object will exit both the End Inside Cluster state and the 2nd State cluster.
While this configuration is perfectly valid, generally the first type of state setup with a Final state and transition is
recommended.
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Parallels in Workflows
Parallels
The Parallel characteristic is used for implementing two or more clusters simultaneously in the workflow. A Parallel
state will automatically get the cluster characteristic indicating that it can only contain clusters as its immediate sub-
states.

Once the Final states of all the clusters that are immediate children of a parallel have been reached, the parallel is
automatically exited upon the next transition.

Exiting a Parallel
Transitions from parallels and Final states in clusters can be simultaneously and automatically triggered by using
the formula Parallel ID.done to name the event. This then allows the object in the workflow tomove to the next
state outside of the parallel.

1. In the picture below, an object entering into the workflow would first enter into the parallel (as it is also the Initial
state), and into the Initial states inside of each cluster simultaneously.

2. The object would then proceed through both clusters simultaneously until the Final state for each cluster is
reached.

3. Once the object has reached the Final states in all clusters inside of the parallel, it then leaves the parallel and
all clusters at the same time and enters into the first state outside of the parallel.
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4. If the event on the transition out of the parallel is namedwith the formula of Parallel ID.done (in this case State-
13.done), the object leaves both Final states in the clusters and the parallel at the same time, and automatically
goes to the Review State which is situated outside of the parallel state. If the event is unnamed, or named
without this formula, it would have to bemanuallymoved to the Review State.

Note:When going through the workflow, it automatically will look for Parallel ID.done events first to be tried
and performed, but if none exist it will then look for transitionswith no special named events.

5. The object then continues through State 2 and ends in Final.

6. While the object is finished going through the workflow, it will not leave the workflow unless coding is in place to
trigger it to leave, or the object ismanually removed.

Note: Prefixing an event on a transition with the ID of the state fromwhich the transition goes and a dot ('.') will
cause the event to be hidden to users working with the workflow in the workbench. This approach should
therefore be used whenever you have a 'system' event that should not be triggerable by human users.

The image below shows an alternate way of configuring a parallel and transition relationship. Here there is a
transition from Initial Cluster out of the parallel straight to Review State. If this transition is performed, the entire
parallel and all its sub-states will be exited regardless of which state the object is in for Cluster 2.
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Note: Parallel States are used for modeling concurrency and should only have child states with the Cluster
Characteristic. Cluster and Parallel States do not typically represent human Tasks.
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Status Flags
Status flags are an aspect of tasks in a workflow that can be useful to group tasks, and are often used to indicate
tasks that need a higher priority or extra attention. For example, status flags can be used to signal tasks that have
been returned to a previous state, tasks that are considered critical or time-sensitive, tasks that have errors, etc.

When a status flag is applied, it is specific to the task-in-state, similar to an assignee. An assignee does not travel
with an object throughout the workflow, rather it is assigned at entry to each state, and upon exit from any state the
current assignee is not retained (unless business rules are set up to record this information). Furthermore, when
an object exits a workflow, there is no longer any assignee associated with it.

Status flags should be thought of in the sameway as assignees. Configuring status flags requires the
understanding that they are specific to a task in a state, and thereforemust be applied at entry to any state. In
addition, tasks in parallel states of a workflow may have different status flags applied in each state.

This section of the documentation describes how to configure status flags.

First, a placemust be created to store the status flags, which is described in the Initial Setup for Status Flags
topic.

Second, status flagsmust be configured for the particular workflow(s) in which they should be used, which is
described in theConfiguring Status Flags topic.
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Initial Setup for Status Flags in Workflows
In order to use status flags for workflows, a setup group that can hold status flag objectsmust be configured. This
only needs to be done once on any system and if already completed, this configuration is not required.

The required setup can be verified by skipping to step 3 below and checking if the option to create a status flag is
available from the setup group that housesworkflows. If you are able to create a status flag, then youmay proceed
directly to theConfiguring Status Flags in Workflows topic to add status flags to a particular workflow.

Prerequisites
The below configuration instructions require that a setup group has first been created for workflows. If the
Workflows setup group seen in step 3 below is not present, see the Initial Setup for Workflows topic to
configure it.

Configuration
1. Go to SystemSetup and selectObject Types and Structures > Basic Object Types to find the object type

calledStatus Flags type.

2. Select theReferences tab, click theAdd Parent link, select theWorkflows node in the dialog that pops up,
and clickSelect to close the dialog. The end result should appear as below:
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This allows status flags to be created under theWorkflows setup group.

3. To create a status flag, go to theWorkflows setup group, right click on it, and selectCreate status flag.

4. Give it an ID, name, and clickCreate. Upon creation, the status flag will appear under the workflows node.
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Create asmany status flags as are needed to support the workflows that require them.

Note: Anyworkflow using status flagswill automatically have a default flag applied to each task. Therefore, it is
useful to create a standard or 'Normal' flag that can be applied as the default.

Status flags are global, meaning that once they are created, they can be used by anyworkflows in the system.
However, status flags are not available in anyworkflows until they have been applied to each workflow in which
they are needed. SeeConfiguring Status Flags in Workflows for details on how to do this.
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Configuring Status Flags in Workflows
Status flags are global objects that must be applied to anyworkflow in which they should be used. Once the
needed status flags are created under the top node that houses them, they can then be associated to the desired
workflow.

This topic describes how to add status flags to workflows, and how to use business rules to set status flags on
tasks.

Prerequisites
Before status flags can be added to workflows, a setup groupmust first exist that can hold status flags, and at least
one status flagmust have been created. For instructions on these processes, see Initial Setup for Status Flags
in Workflows.

In addition, it is important to understand that status flags are specific to a task in a particular state. More information
on this can be found in the introductoryStatus Flags topic.

Configuration
Use the following steps to enable status flags for a workflow.

1. Open theSTEP Workflow Designer of the workflow that needs status flags associated to it.

2. Double-click a blank area in the workflow frame, or right-click inside the workflow frame, and selectEdit
Workflow to display theWorkflow Editor dialog.

3. Select theStatus Flags tab, and add any flags that are needed for the workflow. Note that a 'default status
flag' for the workflow must be selected.

Important: Any new tasks assigned to the workflow will be given the default status flag unless the workflow is
directed to do otherwise via business rules. Any existing tasks already in the workflow will also receive the
default status flag.

4. when finished, close the editor, and save your changes.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 212



5. Aside from the default flag applied to all tasks in the workflow, status flags are not truly enabled until business
rules are created to apply them to tasks. Therefore, instructions for using business rules to apply status flags
are included below.

Using Business Rules to Set Status Flags in Workflows
While it is not required to use workflow variables in conjunction with status flags, it is often useful to create
workflow variables to be associated with each state in which a status flag should be applied. This allows for greater
flexibility in how and when status flags can be set. This is because status flags are somewhat like workflow
assignees in that they are specific to an object in a given state, and cannot be set in advance. Just as you cannot
assign a task to a user until it enters the applicable state, you also cannot bind a status flag to an object's presence
in a workflow until it enters the state. As it is often something from a previous state that determineswhat the status
of the object is in a subsequent state, workflow variables can be used to capture and store what the flag should be,
which can then be set on entry to the appropriate state.

The below instructions describe how to set a status flag based on a transition being taken. For example, a task that
has been rejectedmay need to bemarked as "Critical as it is now spending additional time in the workflow. This is
not the only way to work with status flags, but servesmerely as one example of one common use case. Rather
than using a transition to determine the status flag for a task, any data could be used, such as an attribute value,
reference value, presence or absence of particular data, etc. The options for setting status flags are limited only to
what can be done within business rules.
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However, the options for end users viewing and accessing status flags are limited by the interface in which they
accessworkflows. If workflows are accessed inWebUI, it is not required that status flags be stored in workflow
variables. However, if end users will interact with the workflow only in the STEPWorkbench, status flag
assignmentsmust be stored in workflow variables as that is the only way tomake them visible to the end user.

Use a Workflow Variable to Capture a Status and Apply a Status Flag
The below instructionswalk through an example of how to capture a desired status flag based on a particular
transition being taken, store the information in a workflow variable, and subsequently apply the desired status flag
at entry to a subsequent state.

1. Create a workflow variable to hold the status flag using the button. As status flags are state-specific, it is

recommended to create one workflow variable for each state in the workflow that will have a status flag
determined by some factor other than entering the state, so that when the determining factor is evaluated, the
resulting flag to be applied at any given state can be stored for that state.

For additional information on workflow variables, see theWorkflow Variables section of the documentation.

2. For this example, when a task is rejected, we want to apply a Critical status flag so that users know to quickly
process the task in the Start state. Therefore, we need a business rule to record that the Reject transition has
been taken and store that information. Aswewant the task to then have a Critical status in the Start state, we
will store the information in the StatusFlag_Start workflow variable.

Right-click on the transition that should be recorded, selectEdit Transition, click on theOn Transition tab,
and click theAdd new Business Action link.
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3. Click on theEdit icon button that appears under theOperations tab. This will bring up theEdit Operation
dialog. Select theExecute JavaScript dropdown option.
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4. Under Binds, click theEdit Binds button, and then click theAdd Bind button.
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5. For this example, we need to bind to both current object and current workflow. Input variable names and select
the appropriate binds, as shown below. ClickOK to close the Edit Binds dialog when complete.

6. In the JavaScript field type in the appropriate JavaScript formula. An example is provided below that will set the
value of the workflow variable 'StatusFlag_Start' to 'Critical'. Keep inmind that what is written in the
parentheses is driven by the variable name that waswritten in the bind, the workflow variable created to hold
the status flag value, and the ID of the status flag that is to be assigned.
var inst;

inst = node.getWorkflowInstance(wf);

inst.setSimpleVariable('StatusFlagStart','Critical');

© Stibo Systems - Confidential - STEP Trailblazer 8.1 217



ClickSave in the Edit Operation dialog when finished, and close the Transition Editor using theX button in the
upper right corner.

7. At this point we have only stored what the status flag should be, but have not applied the status flag to any task.
To do that, a rule must be added to the state in which the flag should be assigned.

Right-click on the state and select Edit State. Click on theOn Entry tab, and click theAdd new Business
Action link.

8. Repeat steps 3 - 5 to edit the rule and add the Current Object and CurrentWorkflow binds.

9. Enter the appropriate JavaScript formula. An example is provided below that will take the value of the
previously stored workflow variable and apply it to the task entering the state.
var inst;

var task;

inst = node.getWorkflowInstance(wf);

task = inst.getTaskByID('Start');

if (inst.getSimpleVariable('StatusFlagStart')){

task.setStatusFlagByID(inst.getSimpleVariable('StatusFlagStart'));

}
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ClickSave in the Edit Operation dialog when finished, and close the State Editor using theX button in the
upper right corner.

At this point, rules have been created to capture the desired value for a status flag, and to set it upon entry to a
state. However, in order to make the status flag available for end users to view whenworking with tasks, additional
stepsmust be taken.

l If the user will interact with tasks in the workbench, the workbench view must be configured to include the
workflow variable holding the status flag value. Additional information on configuring views is available in the
Views and Mappings for Workflows topic in theGetting Started with STEP Workflows documentation.

l If users will interact with workflows inWebUI, the appropriate status flag componentsmust be added to the
screen. Additional information on working with status flags inWebUI is available in theStatus Flags in Web
UI topic in theWeb User Interfaces documentation.
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Triggering Workflow Events from Imports
If a workflow is valid for either products, classifications, assets, or entities, it is possible to configure the workflow to
automatically trigger certain transitions if an object in the workflow has an attribute value changed in an import as
long as the event on the transition has the ID of 'sibo.import'. This is helpful in that a user does not have to recheck
any existing items that are already in the desired workflow, nor do they have to take the objects out to be updated,
only to put them back into the workflow again. Instead, the objects already initiated into the workflow will be
updated and then be triggered tomove to the next sate, if the event on the transition has the proper ID.

For example, a user hasObject A in their desired workflow in the Initial state. The Initial state has an event on the
transition coming out of it with the ID of 'stibo.import' going to State 2. The user updates and imports objects, one
of which is Object A. Due to the setup of the Initial state, Object A is updated, and an event is triggeredmoving
Object A to State 2.

Condition for Triggering Workflow Events from Imports
To turn on this functionality for a workflow, select the desired workflow in SystemSetup and check the Listen on
updates from import checkbox on the STEPWorkflow Editor tab.

Make sure that any events that should occur have the proper ID. Again, the Import Manager can only trigger
events with the ID "stibo.import". Thus to have a transition performed for an object in a workflow when it is
changed in an import, the object must be in a state out of which there is a transition with the Event "stibo.import"
(the "stibo.import" event will not be visible in the STEPWorkflow Items editor or on theObject Tasks tab).

Note: It is important to notice that only changes to attribute values (add, modify, remove) will trigger the
"stibo.import" event. Thus, changing a reference, re-parenting an object or similar will not cause the event.

The image below shows a simple workflow with the functionality turned on.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 220



Here, the "stibo.import" event is on the transition from the First state to the Second state and thus, if an object is in
the First state and an attribute value is changed in an import, the transition will be performed.

Whenworking with events generated by imports, there is a special reserved variable named "modifiedAttributes"
available in JavaScript. This variable will hold a list of ID's of the attributes changed in the import. In looking at the
example above, the variable will be available when leaving the 'First' state (On Exit), on the transition (On
Transition + Condition) and when entering the state to which the transition goes (On Entry on the Second state).

Using this reserved variable a user could for instance add a condition on the transition only allowing the transition if
a specific attribute has been changed and has a value after the import. This could be done with a script as follows:

var attChanged = false;

var modArray = modifiedAttributes.toArray();

for(var i = 0; i < modArray.length; i++) {

if(modArray[i] == "ID of Attribute") {

attChanged = true;

break;

}

}

if(attChanged && node.getValue("ID of Attribute").getSimpleValue()) {

condition = true;

}

else {

condition = false;

}

It is optional for users running imports whether or not the import potentially should trigger events. Thus for column
based imports, in the Import Manger on the Advanced Settings page, the checkbox 'Trigger STEPWorkflow
import events on ItemUpdates' controls whether or not events should be triggered.
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In XML, the functionality is enabled / disabled using the STEPProductInformation tag attribute
"STEPWorkflowImportEvent" that can be set to "Y" or "N".

Since it is optional for users whether events should be triggered, the functionality is typically used in imports based
on pre-configured import configurations. A use case could be one where an object is in a state waiting for data to
arrive from an external system via an Inbound Integration Endpoint.

Note: It is only possible to trigger events from imports when running in Domainmode.
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Validate Data in a Workflow
It is common for workflows to require some basic data validation to ensure that quality standards aremet for the
provided data. Data validation can be easily accomplished in a workflow by applying conditions on transitions.

Business conditionswill always evaluate to either true or false. In workflows they can be applied on transitions,
and thus determine whether or not a transition can be performed. If a condition evaluates to true, the taskmay take
the transition. If a condition evaluates to false, the task cannot take the transition andmust attempt another
transition or remain in the state until the data has been corrected and the condition evaluates to true.

When using conditions for basic data validation, the transitions are generally applied on user-accessed states, so
that the user sees an error when attempting to submit via a particular transition if the data does not validate. Note
that conditions should not be used to validate that mandatory attributes are populated as that can be done using
the built-in mandatory attribute functionality, described in theMandatory Attributes section of theWorkflows
documentation.

Data validation can be carried out using any number of functions and/or JavaScript. Additional information on
more advanced topics can be found in theBusiness Rules section of the documentation. The below provides a
simple example of data validation using the attribute value comparison function.

The below example will check to ensure that an attribute, List Price, has a value greater than or equal to .99. It
assumes that a workflow has already been created and a transition exists on which the condition can be added.

1. Double-click on the transition, select theCondition tab, and click theAdd new Business Condition link.
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2. Click the Edit Operation icon, select Attribute Value Comparison from the dropdown.
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3. Select an attribute using the ellipsis [...], choose an operator from the drop down, insert a value for
comparison, and clickSave.

4. Click the [X] in the upper right corner of the Transition Editor to close it, then save and exit the workflow.

Users attempting to submit a task that does not meet the condition will receive an error.

Note that by default, the condition also checks for the presence of a value, returning false when no value is
present.
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Workflow Variables
Whenworking withWorkflows there are two different types of variables available of which one comes in two
variants:

JavaScript Variables - Normal JavaScript variables can be declared in business actions and conditions. The
scope of these variables is limited to the action / condition where they are declared and they are only persisted
during the execution of the action / condition.

Workflow Variables - Workflow variables are string variables defined in theWorkflow Designer. The variables
are global to the workflow instance and the values are stored on the object-in-workflow relation and thus persisted
as long as this relation remains. Workflow variables come in two flavors, 'bound' and 'unbound'.

Bound Workflow Variables
A bound workflow variable is bound to a STEP Attribute and gets its validation from the STEP Attribute. Apart
from getting the validation from a STEP Attribute, bound workflow variables also get the corresponding attribute
editors when a user chooses to display them in workbench views (see theViews and Mappings for Workflows
section of theWorkflows documentation).

Note: The attributes to bind tomust be externallymaintained, non-dimension dependent description attributes
and should not be valid for any object types.

Unbound Workflow Variables
When aworkflow variable is not bound to an attribute, it is a simple string variable with a default workbench view
editor.

The value of unbound variables can be the result of an expression. In the expression panel, a reserved variable
named 'value' is used. Below a script / expression is shown that will set the value of the variable to be the ID of the
current node. Expressions are re-calculated each time the variable is used.

value = node.getID();

Creating a Workflow Variable
To create a workflow variable press the add icon and select AddWorkflow Variable in the 'Workflow
Variables/Attachments' section in the left side of the Designer.
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This will bring up a dialog where the user can enter the ID of the variable and optionally select to bind it to an
'Attribute' or add an 'Expression'.

As noted in theBusiness Rules in Workflows section in theWorkflows documentation, workflow variables are
manipulated through theWorkflowInstance interface. Thus the value of a workflow variable can be obtained from
a business action as follows:

var valueStoredInVariable = node.getWorkflowInstance
(workflow).getSimpleVariable("Variable ID");

And likewise a simple value for a workflow variable could be set with:

node.getWorkflowInstance(workflow).setSimpleVariable("Variable ID", "Value to
be set");

© Stibo Systems - Confidential - STEP Trailblazer 8.1 227



While the above applies to both bound and unbound variables, for bound variables a value object can be obtained.
This can be done with:

var valueObj = node.getWorkflowInstance(workflow).getValue("ID of Attribute the
variable is bound to");

Workflow Variables in Use
Consider a user group which consists of 5 users. All of these 5 users have access to a particular workflow, and can
submit a product from the Edit to the Review state. For this workflow, because there is a requirement to identify
which of these 5 users submitted a particular product, a business rule has been set up to save the details to an
attribute. This business action is set on the desired state in the State Editor on the 'On Exit' tab. In this case it is on
the Edit sate.

To create this business rule, a workflow variable first needs to be defined, which is 'Released by' for this workflow.
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Then a business rule needs to be written to call the workflow variable asmentioned below:

var assigneeID = step.getCurrentUser().getID();

node.getWorkflowInstance(workflow).setSimpleVariable("Variable ID", assigneeID);

Note: In this formula, "Variable ID" should be replaced with the ID of the actual workflow variable for the workflow
in use.
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With this business action in place, when a product is submitted, the business rule is executed and the user ID of
the user who submitted the product is stored. This is visible in the STEPWorkflow Items tab if this wasmapped in
the views andmappings View Editor.

For more on setting up views andmappings, see theViews and Mapping for Workflows topic in the
Workflows documentation.

Workflow Variables in Web UI
Workflow variables are also supported inWebUI, where they can be added to relevant components using the
Workflow Variable or Workflow Variable Header components. In addition, workflow variables can be added to
submit actions (Submit Action or Submit fromGrid Action).
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Web Services for SOAP Requests for Workflows
Complete documentation for Web Services functionality related to workflows can be found in the STEP API
documentation at [system]/sdk. This topic provides some basic information and an example of a simple SOAP
request, but should not be considered comprehensive.

The STEPWeb Services API contains the followingmethods related to STEPWorkflows:

startWorkflow - Method for starting aWorkflow on anObject

triggerWorkflowEvent - Method for triggering aWorkflow Event for anObject in a State in aWorkflow

deleteWorkflowInstance - Method for removing anObject from aWorkflow. I.e., deleting the instance.

getTasks - Method for retrieving info about which States anObject is in in specifiedWorkflow. For each State
apart from the ID, a STEP url for the Assignee and the time of entering the State will be returned.

initiateItemInStateflow - Legacy version of startWorkflow

triggerStateflowEvent - Legacy version of triggerWorkflowEvent

removeItemFromStateflow - Legacy version of deleteWorkflowInstance

getItemStateInfo - Legacy version of getTasks

An example using startWorkflow is below:

<soapenv:Envelope xmlns:soapeny="http://schemas.xmlsoap.org/soap/envelope/"

xmlns:ns="http://stibo.com/step/ws/step/1.0"

xmlns:ns1="http://stibo.com/step/ws/types/1.0">

<soapenv:Header/>

<soapenv:Body>

<ns:startWorkflowRequest>

<ns:accessContext>

<ns1:userName>[Username]</ns1:userName>

<ns1:password>[Password]</ns1:password>

<!--Optional:-->

<ns1:passwordType></ns1:passwordType>

<!--Optional:-->

<ns1:contextUrl>step://context?id=[Context ID]</ns1:contextUrl>

<!--Optional:-->

<ns1:workspaceUrl>step://workspace?id=[Workspace ID]</ns1:workspaceUrl>

</ns:accessContext>

<ns:nodeURL>step://product?[Node ID]</ns:nodeURL>

<ns:WorkflowID>[Workflow ID]</ns:WorkflowID>

<!--Optional:-->
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<ns:message>[Message]</ns:message>

</ns:startWorkflowRequest>

</soapenv:Body>

</soapenv:Envelope>
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Workflow Attachments
While not the only reason, 'Workflow Attachments' are typically used for holding files that are necessary for users
handling tasks in states. This could be written instructions, images, data sheets etc. Once the attachment is in
place, when a user receives or gets a specific task(s), they can access the attachment and follow the specified
instructions / guidelines.

Using workflow attachments a user can attach files to workflow instances. Also, like the workflow variables,
workflow attachments are global to the workflow instance.

Note: Users should be familiar with the navigation to the STEPWorkflow Designer and defining the views and
mappings. SeeCreating a Workflow in theWorkflows documentation for more on the workflow designer. Also,
seeViews and Mappings for Workflows in theWorkflows documentation for additional information on view
andmapping.

Workflow Attachment Configurations
As described in theConfiguring Views for Workflows section in theWorkflows documentation, the
'WorkflowAttachment' component allowsUsers to add, open, download and delete workflow attachments through
views.

Attachments are defined in the left pane of theWorkflow Designer. To add a workflow attachment:

1. Click on the 'AddWorkflow Variables/Attachments' icon, , and select the optionAdd Workflow
Attachment.

2. In the dialogue that appears, enter the ID and clickOK.

If multiple attachments are required then check the option for 'Multivalued'.

Note: If a user needs to edit or delete a workflow attachment added in this section, they can click on the edit icon,

, or they can click on the remove icon, , to make any necessary changes.
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3. Next go to Edit > Edit Workbench Views and Mappings.
4. In the View Editor, right-click the view that needs an attachment added to it, and select Add Column >

Component.

5. Under the Component dropdown, select 'Workflow Attachment'. Once selected a dropdown to add an
'Attachment' will appear. Select the attachment that was just created in step 2. For this example it is called
'Workflow Attachment.'
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6. Enter a title and then decide if either 'ReadOnly', or 'Mandatory' need to be checked before exiting the View
Editor and hitting 'Save and Exit' in the STEPWorkflow Designer. Note that neither one of these has to be
checked. If 'ReadOnly' is left unchecked then a user can download the attachment and upload files. These files
will be attached to the workflow instance.

Component Returned Value

ReadOnly If marked as this the add and delete optionswill be disabled, but users will still be able to open
and download attachments. However, any uploaded files will not be stored in the STEP
database. Instead, theywill live in the application server file system in a path specified via the
configuration property 'Install.STEPWorkflowArea'.

Mandatory Tell the user that the attachment is required information.

Attaching a File in a Workflow
Now that the configurations are in place, the steps below show a user how to attach and remove a file.

1. Navigate to the STEPWorkflow tab, select the desired workflow, and click on the corresponding state that the
workflow attachment wasmapped to in the above steps.

2. In the STEPWorkflow Items tab, click on the ellipses button, , next to the desired product and select the file
from the system that is to be attached.
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3. Double click on the attachment to open it.

4. To remove the attachment, click on the red 'x' button, .

It is worth noting that workflow attachments are instance specific, and valueswill be deleted together with the
instance.

In the public API you can obtain a 'WorkflowAttachment' object through the 'WorkflowInstance' interface via
'WorkflowInstance.getAttachmentByID'("Attachment ID") and have variousmethods available on the returned
object.
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Note: The files referenced by attachments are stored on the application server in the directory pointed to by
config property "Install.STEPWorkflowArea". If you are on a clustered environment, the directory should be on a
shared drive. Workflow attachments are not stored as assets in STEP.
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